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Preface

This guide describes how to install, configure and use VERITAS NetBackup SAP
Extension for Oracle on a UNIX platform. In this guide, VERITAS NetBackup for SAP on
UNIX Extension for Oracle is referred to as NetBackup for SAP on UNIX.

For specific information about the NetBackup Server software, refer to:
¢ NetBackup System Administrator’s Guide for UNIX, if you have a UNIX server,
or
¢ NetBackup System Administrator’s Guide for Windows if you have a Windows NT server.

This document is the same as NetBackup AdminGuide SAP Unix.pdf distributed
with the NetBackup for SAP on UNIX software.




Audience

Audience

This guide is intended for the:

*

*

Oracle database system administrator responsible for configuring and using the SAP
system to back up and restore Oracle databases.

The NetBackup system administrator responsible for configuring NetBackup.

A system administrator is defined as a person with system administrator privileges and
responsibilities.

This guide assumes:

*

*

*

A basic understanding of system administration.
You have a working understanding of NetBackup client and server software.
You are familiar with the information covered in the following NetBackup manuals:

¢ NetBackup System Administrator’s Guide for UNIX, Volumes | and Il, or NetBackup
System Administrator’s Guide for Windows, Volumes | and |1

¢ NetBackup Troubleshooting Guide for UNIX and Windows

A thorough understanding of the SAP environment.

What Is In This Guide?

This guide is organized as follows:

*

The Introduction contains an overview of NetBackup for SAP on UNIX terminology
and a technical overview of the NetBackup for SAP on UNIX backint interface.

Installation provides instructions on installing NetBackup and the NetBackup for SAP
on UNIX software.

Configuration has instructions for configuring your installation. You will also find
troubleshooting and debugging instructions in this chapter.

Using NetBackup for SAP on UNIX provides operating instructions for your
installing of NetBackup for SAP on UNIX.

The Troubleshooting chapter describes the various Troubleshooting tools available
with NetBackup for SAP on UNIX.

The manual also contains the following Appendices.

*

*

Appendix A, “NetBackup for SAP backint Command Line” describes the backint
command line.

Appendix B, “backint -i in_ file Contents” describes the in file.

NetBackup for SAP System Administrator’s Guide for UNIX



Getting Help

Appendix C, “backint -o out file Contents” describes the contents of the
out file.

Appendix D, “Environment Variable” describes the environmental variables.
Appendix E, “bp . conf File” describes the bp . conf file.

Appendix F, “backint -p par fileor initSID.utl Contents” describes the
contents of the par file.

Appendix G describes the method for using NetBackup for SAP to back up SAPDB.

Getting Help

VERITAS offers you a variety of support options.

Accessing the VERITAS Technical Support Web Site
The VERITAS Support Web site allows you to:

*

® & 6 ¢ o o o

obtain updated information about NetBackup for SAP, including system
requirements, supported platforms, and supported peripherals

contact the VERITAS Technical Support staff and post questions to them
get the latest patches, upgrades, and utilities

view the NetBackup for SAP Frequently Asked Questions (FAQ) page
search the knowledge base for answers to technical support questions
receive automatic notice of product updates

find out about NetBackup for SAP training

read current white papers related to NetBackup for SAP

The address for the VERITAS Technical Support Web site follows:

*

http://support.veritas.com

Subscribing to VERITAS Email Notification Service

Subscribe to the VERITAS Email notification service to be informed of software alerts,
newly published documentation, Beta programs, and other services.

Go to http://support.veritas.com. Select a product and click “E-mail Notifications” on the
right side of the page. Your customer profile ensures you receive the latest VERITAS
technical information pertaining to your specific interests.

Preface
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Accessing VERITAS Telephone Support

Telephone support for NetBackup for SAP is only available with a valid support contract.
To contact VERITAS for technical support, dial the appropriate phone number listed on
the Technical Support Guide included in the product box and have your product license
information ready for quick navigation to the proper support group.

To locate the telephone support directory on the VERITAS web site
1. Open http://support.veritas.com in your web browser.

2. Click the Phone Support icon. A page that contains VERITAS support numbers from
around the world appears.

Accessing VERITAS E-mail Support
To contact support using E-mail on the VERITAS web site
1. Open http://support.veritas.com in your web browser.

2. Click the E-mail Support icon. A brief electronic form will appear and prompt you to:
& Select a language of your preference
¢ Select a product and a platform
¢ Associate your message to an existing technical support case
.

Provide additional contact and product information, and your message

3. Click Send Message.

Contacting VERITAS Licensing

For license information call 1-800-634-4747 option 3, fax 1-650-527-0952, or e-mail
amercustomercare@veritas.com.

NetBackup for SAP Manuals

The following manuals, along with the online help, are included in the NetBackup for
SAP documentation set. For a more detailed listing of NetBackup documents, refer to
NetBackup Release Notes for UNIX and Windows.

If you have a UNIX server, refer to these documents:

¢ VERITAS NetBackup System Administrator's Guide for UNIX, Volume |

-——v X||
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*

NetBackup_AdminGuidel_UNIXServer.pdf

Explains how to configure and manage NetBackup on a UNIX server, including
managing storage units, backup policies, catalogs and host properties.

VERITAS NetBackup System Administrator's Guide for UNIX, Volume 11
NetBackup_AdminGuidell_UNIXServer.pdf

Explains additional NetBackup features such as notify scripts, enhanced
authorization and authentication, and role-based security. The guide also discusses
using NetBackup with AFS, Intelligent Disaster Recovery (IDR), and the BE Tape
Reader.

NetBackup Media Manager System Administrator’s Guide for UNIX

Explains how to configure and manage the storage devices and media on UNIX
NetBackup servers. Media Manager is part of NetBackup.

VERITAS NetBackup Troubleshooting Guide for UNIX and Windows

Provides troubleshooting information for UNIX- and Windows-based NetBackup
products, including Media Manager.

If you have a Windows server, refer to these documents:

*

VERITAS NetBackup System Administrator’s Guide for Windows, Volume |
NetBackup_AdminGuidel_WinServer.pdf

Explains how to configure and manage NetBackup on a Windows server, including
managing storage units, backup policies, catalogs and host properties.

VERITAS NetBackup System Administrator’s Guide for Windows, Volume |1
NetBackup_AdminGuidell_WinServer.pdf

Explains additional NetBackup features such as notify scripts, enhanced
authorization and authentication, and role-based security. The guide also discusses
using NetBackup with AFS, Intelligent Disaster Recovery (IDR), and the BE Tape
Reader.

NetBackup Media Manager System Administrator’s Guide for Windows

Explains how to configure and manage the storage devices and media on Windows
NetBackup servers. Media Manager is part of NetBackup.

VERITAS NetBackup Troubleshooting Guide for UNIX and Windows

Provides troubleshooting information for UNIX- and Windows-based NetBackup
products, including Media Manager.

Preface
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Other Documentation

Other Documentation

For this product, you may also need the following manuals from Oracle Corporation:
¢ Oracle Enterprise Backup Utility Installation and Configuration Guide

For this product, you may also need the following manuals from SAP Corporation:

& BC SAP Database Administration: Oracle

You may also need the following manual from SAP AG:

¢ BC-BRI BACKINT Interface R/3 System, Release 3.x and 4.x

Glossary

If you encounter unfamiliar terminology, consult the NetBackup online glossary. The
glossary contains terms and definitions for NetBackup and all additional NetBackup
options and agents.

The NetBackup online glossary is included in the NetBackup help file.
To access the NetBackup online glossary

1. Inthe NetBackup Administration Console, click Help > Help Topics.
2. Click the Contents tab.

3. Click Glossary of NetBackup Terms.

Use the scroll function to navigate through the glossary.

Accessibility Features

NetBackup contains features that make the user interface easier to use by people who are
visually impaired and by people who have limited dexterity. Accessibility features
include:

¢ Support for assistive technologies such as screen readers and voice input (Windows
servers only)

¢ Support for keyboard (mouseless) navigation using accelerator keys and mnemonic
keys

For more information, see the NetBackup System Administrator’s Guide for Windows,
Volume | or the NetBackup System Administrator’s Guide for UNIX, Volume 1.

-——v Xiv
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Conventions

Conventions

The following conventions apply throughout the documentation set.

Product-Specific Conventions

The following term is used in the NetBackup for SAP 5.1 documentation to increase
readability while maintaining technical accuracy.

*

Microsoft Windows, Windows

Terms used to describe a specific product or operating system developed by
Microsoft, Inc. Some examples you may encounter in NetBackup documentation are,
Windows servers, Windows 2000, Windows Server 2003, Windows clients, Windows
platforms, or Windows GUI.

When Windows or Windows servers is used in the documentation, it refers to all of
the currently supported Windows operating systems. When a specific Windows
product is identified in the documentation, only that particular product is valid in that
instance.

For a complete list of Windows operating systems and platforms that NetBackup
supports, refer to the NetBackup Release Notes for UNIX and Windows or go to the
VERITAS support web site at http: //www. support .veritas.com.

Typographical Conventions

Here are the typographical conventions used throughout the manuals:

Conventions

Convention Description

GUI Font Used to depict graphical user interface (GUI) objects, such as fields,
listboxes, menu commands, and so on. For example: Enter your
password in the Password field.

Italics Used for placeholder text, book titles, new terms, or emphasis. Replace

placeholder text with your specific text. For example: Replace filename
with the name of your file. Do not use file names that contain spaces.

This font is also used to highlight NetBackup server-specific or operating
system-specific differences. For example: This step is only applicable for
NetBackup Enterprise Server.

Preface
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Conventions (continued)

Convention Description

Code Used to show what commands you need to type, to identify pathnames
where files are located, and to distinguish system or application text that
is displayed to you or that is part of a code example.

Key+Key Used to show that you must hold down the first key while pressing the
second key. For example: Ctrl+S means hold down the Ctrl key while
you press S.

You should use the appropriate conventions for your platform. For example, when
specifying a path, use backslashes on Microsoft Windows and slashes on UNIX.
Significant differences between the platforms are noted in the text.

Tips, notes, and cautions are used to emphasize information. The following samples
describe when each is used.

Tip  Used for nice-to-know information, like a shortcut.

Note Used for important information that you should know, but that shouldn’t cause any
damage to your data or your system if you choose to ignore it.

Caution Used for information that will prevent a problem. Ignore a caution at your own
risk.

Command Usage
The following conventions are frequently used in the synopsis of command usage.
brackets [ ]
The enclosed command line component is optional.
Vertical bar or pipe (])

Separates optional arguments from which the user can choose. For example, when a
command has the following format:

command argl|arg2

In this example, the user can use either the argl or arg2 variable.

-——v XVi
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Navigating Multiple Menu Levels

When navigating multiple menu levels, a greater-than sign (>) is used to indicate a
continued action.

The following example shows how the > is used to condense a series of menu selections
into one step:

% Select Start > Programs > VERITAS NetBackup > NetBackup Administration
Console.

The corresponding actions could be described in more steps as follows:
1. Click Start in the task bar.

2. Move your cursor to Programs.

3. Move your cursor to the right and highlight VERITAS NetBackup.

4. Move your cursor to the right. First highlight and then click NetBackup
Administration Console.

Preface
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Introduction 1

NetBackup for SAP on UNIX integrates the database backup and recovery capabilities of
SAP Tools with the backup and recovery management capabilities of NetBackup and its
Media Manager.

This chapter introduces NetBackup for SAP on UNIX and how it relates to both SAP Tools
and NetBackup. The following topics introduce NetBackup for SAP on UNIX.

¢ Terminology for NetBackup for SAP on UNIX
¢ Features of NetBackup for SAP on UNIX
¢ Technical Overview of NetBackup for SAP on UNIX
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Terminology for NetBackup for SAP on UNIX

This section explains important terms that may be new to an SAP for Oracle database
administrator or a NetBackup administrator. Refer to the following graphic when
reviewing the terminology in this section.

SAP Environment

[ [ [
Oracle P [ [ |

Database | |

]
SAP NetBackup SAP NetBackup
brback .
sapda Y rhactup backint —
> brrestore
) bpbackup
% brarchive Interface TNy
| ' : prestore
brinquire
SAP Tools
NetBackup

This section describes NetBackup terms as they apply to NetBackup for SAP on UNIX.

NetBackup NetBackup backs up and restores files, directories, raw partitions, and
databases on client systems that have SAP databases.

NetBackup policy NetBackup policies define criteria for backups and restores. These
criteria include storage unit and media to use, backup schedules,
clients, files to back up, or backup templates or scripts to execute.

NetBackup schedule NetBackup schedules control NetBackup operations such as: when
backups can occur, the type of backup (full, incremental) to perform,
and how long NetBackup retains the image (retention level).

Administrator-directed NetBackup administrators are able to perform remote backups of all
backups files, directories, databases, and raw partitions contained on client
systems within a client/server network via NetBackup interfaces.

User-directed backups and NetBackup users are able to perform backups of all files, directories,
restores databases, and raw partitions contained on client systems within a
client system.

Graphical interfaces Graphical user interfaces are available for both users and
administrators.

v 2 NetBackup for SAP System Administrator’s Guide for UNIX
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Media Manager The Media Manager provides complete management and tracking of
all devices and media used during backups and restores.

For explanations of other NetBackup terms, consult the NetBackup online glossary. For
instructions, see the “Glossary” section in the Preface.

SAP Tools

The SAP Environment consists of many modules and applications. One small piece of the
SAP Environment is the SAP Tools. SAP Tools provide:

¢ backup and recovery function for an Oracle database,

¢ Oracle administration by communicating with NetBackup through NetBackup for

SAP on UNIX.

sapdba sapdba is a menu-driven utility, with menus designed to reflect
the user’s point of view.
sapdba provides easy access to brbackup, brarchive,
brrestore for database backup/restore. The tool can restore a
backup of an entire database or reset the database to a previous
state.

brbackup This command brings database servers on-line or off-line, checks
the status of SAP files, and places database tablespaces into
BACKUP mode to guarantee their data consistency. brbackup
provides on-line or off-line backup of control files, data files, and
on-line redo log files. It also keeps a profile and log of each
backup.
brbackup uses the NetBackup software, through NetBackup for
SAP on UNIX, for:
¢ SAP datafile backups
& datafile and on-line log backups
¢ error handling

brarchive This command archives Oracle off-line redo log files by
communicating with the NetBackup for SAP on UNIX backint
interface. These files are copied by Oracle in its archiving
directory. brarchive ensures that duplicates of these logs are
available and that original files are not deleted prematurely. This
command also keeps a profile and log of each archive.

———
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brrestore

SAP script

backint Interface

Backup Function

Restore Function

This command recovers database data files, control files, and
on-line redo log files through the NetBackup for SAP on UNIX
backint interface. brrestore ensures that sufficient space is
available prior to restoring these files, and removes files that will
be overwritten during the recovery. This command also provides
a query mode.

This is a small script that contains SAP commands such as
brbackup and brrestore.

The NetBackup for SAP on UNIX backint interface
communicates instructions from SAP Tools to NetBackup. The
backint interface is the implementation of the SAP system’s
BC-BRI BACKINT Interface specification.

The backup function of the backint interface supports and
defines the SAP brbackup and brarchive tools to NetBackup.
brbackup/brarchive communicate with the backint
interface through an in_file and an out_file parameter. The in_file
parameter includes a list of files to be backed up or archived. The
out_file parameter reports the status for each file and assigns a
Backup ID (BID) to each file. In the event of a partial backup, this
function will identify successfully backed up files to the user.

The restore function of the backint interface supports and
defines the brrestore tool to NetBackup. It communicates with
the backint interface through the in_file parameter and out_file
parameter. The in_file parameter includes a list of files to be
restored through NetBackup. It also includes the Backup ID (BID)
assigned during the backup function. The out_file parameter
contains the status of the restore for each file. When the
NetBackup restore operation is complete, the restore function lists
successfully restored files. It will also list BIDs used during the
operation.

The BID is assigned by NetBackup during the backup function. It
may identify one or more backup runs, a single file backup or a
group of files. During a backup function, the BID is submitted to
the out_file parameter. During the restore and inquiry functions,
the BID can only be set in the in_file parameter. For more details,
refer to “backint Command Line” on page 87.

If the BID is not set, the restore function will use the BID of the last
backup. As an option, this function can also include a list of
directories into which files will be restored. For more details, refer
to “backint -1 in_file Contents” on page 91.

NetBackup for SAP System Administrator’s Guide for UNIX
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Inquiry Function The inquire function supports and defines the sapdba tool to
NetBackup. sapdba uses the in_file parameter and the out_file
parameter to collect backup information. The in_file parameter
contains optional BIDs and filenames.

If only a #NIULL is received on the in_file parameter, a list of BIDs
will be generated to the out_file parameter. If a BID is received, a
list of files belonging to the BID is generated. If a filename is
entered along with the #NULL, a list of BIDs containing that file
will be listed.

Features of NetBackup for SAP on UNIX

This section describes the NetBackup for SAP on UNIX main features.

NetBackup for SAP on UNIX main features

Feature

Description

Media and device
management

Scheduling facilities

Multiplexed backupsand
restores

All devices supported by Media Manager are available to
NetBackup for SAP on UNIX.

NetBackup scheduling facilities on the master server can be
used to schedule automatic and unattended SAP backups.

This also lets you choose the times when these operations can
occur. For example, to prevent interference with normal
daytime operations, you can schedule your database backups
to occur only at night.

NetBackup for SAP on UNIX lets you take advantage of
NetBackup’s multiplexing capabilities. Multiplexing directs
multiple data streams to one backup device, thereby reducing
the time necessary to complete the operation.

Chapter 1, Introduction
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NetBackup for SAP on UNIX main features

Feature

Description

Transparent execution of
both SAP and regular file
system backup and
restore operations

Sharing the same devices
and tapes used during
other file backups

Centralized and
networked backup
operations

Graphical user interfaces

Parallel backup and
restore operations

All backups and restores are run simultaneously and
transparently without any action from the NetBackup
administrator.

A database administrator can run database backup and restore
operations through NetBackup or use SAP Tools as if
NetBackup were not present.

An administrator or any other authorized user can use
NetBackup to run database backups and restores.

It is possible to share the same devices and media used for
other backups or to give SAP exclusive use of certain devices
and media.

From the NetBackup master server, you can schedule
database backups or start them manually for any client. The
SAP databases can also reside on hosts that are different from
the devices on which NetBackup stores the backups.

NetBackup provides the following graphical user interfaces
for client users and administrators:

¢ Backup, Archive, and Restore user interface

¢ Client user motif interface, xbp

¢ NetBackup Administration Console for Java

¢ NetBackup Administration Console for Windows

A database administrator or NetBackup administrator can
start backup or restore operations for SAP from the
NetBackup graphical user interface on the master server.

NetBackup for SAP on UNIX supports the parallel backup and
restore capabilities of the SAP Tools. This permits the user to
run more than one tape device at a time for a single SAP
backup or restore, thereby reducing the time necessary to
complete the operation.
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Technical Overview of NetBackup for SAP on UNIX

The following figure illustrates the components and architecture for SAP and NetBackup.

[SAP Applications|

Oracle

Database

DB Agent [brbackup| |brarchive| |brrestore] | sa})da|
Operation

Interface  |packint| [backint]| [backint| [backint]
Database/File Netl:%ackup for SAP

Backup/Restore

Robots/Media

SAP Tools act as database agents, responsible for all database related tasks. These
database agents (brbackup, brarchive, and brrestore) communicate with
NetBackup through the NetBackup for SAP on UNIX backint interface. The sapdba
component of SAP Tools also accesses the backup catalog used by NetBackup in order to
determine the status of the valid backups.
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The example network below shows the major components in a NetBackup for SAP on
UNIX backint interface configuration.

System containing SAP environment and Oracle database
NetBackup for SAP supplies:

Oracle database/ — backint Interface
_ — Sample configuration program
SAP software supplies: E; a — Sample script files
— SAP BR tools:

sapda, Additional required NetBackup software:
brbackup, — NetBackup Master Server
brrarchive — NetBackup Client
brrestore

Network (TCP/IP) k
NetBackup master server
or remote media server
—
NetBackup software:
— NetBackup Master Server

— NetBackup Media Server
(if system is a media server)

Tape or optical
storage device

The host with the database must be a NetBackup client and have NetBackup for SAP on
UNIX, SAP software, and Oracle software installed.

The storage devices are connected to the NetBackup master server. A NetBackup media
server can access the storage devices through the master server. Both the master server
and the media server must have NetBackup server software installed.

Using NetBackup requires that the administrator create an SAP script with commands for
controlling database backup or recovery. For example, an SAP script to back up Oracle
databases would have a brbackup command. A separate SAP script is needed for each
type of operation (see “Creating Scripts” on page 49 for more information on these SAP
scripts).
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Sequence of Operation

NetBackup users or schedules start database backups or restores by selecting an SAP
script. A NetBackup process called bphdb starts the SAP script on the client. The SAP
application then starts the requested operation on the databases.

NetBackup for SAP NetBackup

SAP Tools
brbackup
brrestore

etc. \
\\ Command Line
script
— bphdb

bpbackup

Database
bprestore

Files

NetBackup Client

NetBackup Master Server

¢ scheduler
~ ~

NetBackup

For a backup, brbackup calls the NetBackup for SAP on UNIX backint interface. From
this point the operation is similar to a user-directed backup.

A restore works in essentially the same manner except that the NetBackup for SAP on
UNIX backint interface issues a bprestore command, causing NetBackup to retrieve
the data from secondary storage and send it to the client.

Chapter 1, Introduction



Technical Overview of NetBackup for SAP on UNIX

- 10 NetBackup for SAP System Administrator’s Guide for UNIX



Installation 2

This chapter describes the NetBackup for SAP on UNIX installation and setup procedures.
It includes a section on installation prerequisites.

V¥ To locate the latest Database Agent information on the VERITAS support web site

1.

2.

Go to the VERITAS support web page: http://www . support .veritas.com.

From the Select Product Family list, choose NetBackup Products. The Select Product
window refreshes showing a list of NetBackup products.

Select one of the NetBackup products. The page refreshes and displays a search
window with four tabs.

Select 5.1 in the Product Version drop-down field.
Select a Product Platform.

Click the Compatibility tab. The page refreshes showing documents that contain
compatibility information.

Click on the title of the document link for NetBackup Database Agent Compatibility
List. A document appears that contains a downloadable file that enables you to view
the supported database spreadsheet for this release.




Installation Prerequisites

Installation Prerequisites

Before installing NetBackup for SAP on UNIX, be sure you have completed the following
procedures:

2
<

Install the NetBackup server software on the server.

The NetBackup server platform can be any of those that NetBackup supports.

Refer to the NetBackup Installation Guide for UNIX or the NetBackup Installation Guide
for Windows.

Install the NetBackup client software on the client where you will be backing up the
databases.

Refer to the NetBackup Installation Guide for UNIX for installation instructions.

Now you are ready to install NetBackup for SAP on UNIX on the client where you will be
backing up the databases. Refer to the next section for detailed instructions on installing
NetBackup for SAP on UNIX.

Guidelines for Installing NetBackup for SAP on UNIX in a
Cluster

*

Prior to installing NetBackup for SAP on UNIX, the NetBackup server must be
installed and configured to work in a cluster. (This is accomplished by following the
instructions in the NetBackup Installation Guide for UNIX, including running the
cluster config script after the NetBackup server software has been installed.)

Commands such as bpplclients and update dbclients must be run from the
active NetBackup node. If you are pushing the database agent software to clients
located in a cluster, specify the individual node names (not virtual names) in the list of
clients.

If installing NetBackup for SAP on UNIX on a clustered NetBackup server, freeze the
active NetBackup node before beginning the installation. Install on all the inactive
nodes, then install on the active node. After you successfully install on the active
node, unfreeze this node.

The cluster config script only needs to be run after the NetBackup server
software has been installed. You do not need to run this script after installing
NetBackup for SAP on UNIX on a NetBackup server or if you wish to install
NetBackup for SAP on UNIX on a machine on which only the NetBackup client is
installed.
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Installing NetBackup for SAP on UNIX

There are two ways to install database agent software.

*

Remote installation: Loads the software on a master server. The user then pushes the
database software out to affected clients.

Refer to the following section.
Local installation: Loads and installs the software only to the local machine.

Refer to “Local Installation of NetBackup for SAP on UNIX” on page 18.

Remote Installation of NetBackup for SAP on UNIX

During a remote installation, NetBackup for SAP on UNIX files are loaded onto the
current machine, which must be a UNIX master server. The software is then distributed to
the clients and installed.

Note In a clustered environment, the capability to push client software is only available

from the active node.

Installation Requirements

*

The version of the NetBackup client and the version of NetBackup for SAP on UNIX
must be the same (for example, 5.1).

There must be adequate disk space on each client that will receive the software.

Less than one megabyte of additional disk space is required in the client’s
install path/netbackup directory. However, more disk space may be necessary
at run time.

NetBackup version 5.1 software is installed and operational on each SAP client.

In a clustered environment, NetBackup server software has been installed and
configured to work in a cluster. (This is accomplished by following the instructions in
the NetBackup Installation Guide for UNIX, including running the cluster config
script after the NetBackup server software is installed.)
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Remote Installation Instructions

To perform a remote installation

1.

If installing NetBackup for SAP on UNIX on a clustered NetBackup server, first refer
to the “Guidelines for Installing NetBackup for SAP on UNIX in a Cluster” earlier in
this chapter.

Log in as the root user on the server.

If you are already logged in, but are not the root user, run the following command.

su - root

Make sure a valid license key for NetBackup for SAP on UNIX has been registered. To
view or add license keys, perform one of the following:

*

*

Run the following command:
install path/netbackup/bin/admincmd/get license key.

Open the NetBackup Administration Console and choose Help > License Keys.

Insert the CD-ROM into the drive.

Change the working directory to the CD-ROM directory.

cd /CD mount point

Load the software on the server by executing the install script.

./install

a.

Select the NetBackup Database Agent Software option.
The following prompt appears:

Do you want to do a local installation? (y/n) [n]

Answer n.

You are presented with a menu of all database agents available on the CD-ROM.
Select the NetBackup for SAP option.

Enter g to quit selecting options.

A prompt appears asking if the list is correct.

Answer y.
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The install script identifies the types of client software loaded during the
installation of the NetBackup server. By default, any matching NetBackup for
SAP on UNIX software is automatically loaded. If there are more platforms
available, the script displays a menu giving you the opportunity to add more
client types to the default list. Once the list is complete, database agent version
files, compressed tar files and the install dbext script are copied to directory
install path/netbackup/dbext.

7. Distribute and install the NetBackup for SAP on UNIX software on each client as
described in the next sections.

Note In a clustered environment, the capability to distribute client software is only
available from the active node.

There are two types of installation processes.

*

initial install: Use an initial install if the clients you intend to update have not been
added to policies of type SAP.

upgrade install: Use an upgrade install if all the clients you intend to update
already have been added to policies of type SAP.

Note The NetBackup version level (for example, 5.1) running on the clients you wish to
update must be the same as the version level of the NetBackup for SAP on UNIX
being installed.

Initial Installation on Clients

V¥ To perform an initial install on the clients

1. Run the following command to create a file containing a list of clients currently
configured in the NetBackup database.

cd install path/netbackup/bin
./admincmd/bpplclients -allunique -noheader > filename

where £ilename is the name of the file to contain the list of unique clients. If no
clients have been configured in the NetBackup database, and therefore £ilename is
empty, create £ilename using the same format as that generated by bpplclients.

bpplclients generates output in following format:

hardware operating_system client_name
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where:

hardware is the hardware name. For example, execute the 1s command in
directory install path/netbackup/client.

operating_system is the operating system name. For example, execute the 1s
command in directory install path/netbackup/client/hardware.

client_name is the name of the client.
For example, the contents of filename might look like this:
Solaris Solaris8 curry
RS6000 AIX4.3.3 cypress
Edit filename.

This is an optional step. Use it if the contents of filename need to be changed. Edit
filename to contain only those clients you wish to update with NetBackup for SAP on
UNIX software.

Specify filename in the update dbclients command.

For example:

cd install path/netbackup/bin
./update dbclients SAP -ClientList filename

Only clients listed in filename are updated.

Upgrade Installation on Clients

V¥ To perform an upgrade installation on the clients

1. Execute the following command.

cd install path/netbackup/bin
./update dbclients SAP ALL ALL

This command looks at all possible clients and updates only the clients currently in
the SAP policy type.

Instead of ALL, ALL, you may use -ClientList filename as explained in “Initial
Installation on Clients” on page 15.
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Note With an initial or upgrade install, some clients may be skipped and not updated.
Possible reasons are:
- the client is a PC client (which cannot be updated from a UNIX server)
- NetBackup for SAP on UNIX does not support that client's platform type
- the NetBackup for SAP on UNIX software for that client type was not loaded onto
the server in step 6 of the “Remote Installation Instructions” on page 14
- (if using the ALL. ALL method) the client does not belong to the SAP policy type
All skipped clients are available in a file whose name is displayed by
update dbclients.

The number of updates required to distribute the software to the clients is displayed.
If more than one update will occur, you will see the following prompt:

Enter the number of simultaneous updates you wish to take place. 1 - max dflt
(must be in the range of 1 to max; default: dfit).

where:

max is the maximum number of simultaneous updates that is allowed. The value
displayed ranges from 1 to 30.

dflt is the default number the program uses if you press Enter. The value
displayed ranges from 1 to 15.

For example, if three client updates will be performed, the max and dflt values shown
would be 3. If 50 client updates will be performed, the max value shown would be 30
and the dflt value shown would be 15.

update dbclients starts the number of updates that you specify. If this number is
less than the total number of client updates to be performed, new updates start as the
previous updates finish until all of the updates have been completed.

Based on your answer, the time it will take to update the clients is displayed, followed
by this question:

Do you want to upgrade the clients now? (y/n) [yl

2. Enter y or n for the prompt.

If you answer n, update dbclients quits and leaves the list of clients it would
have updated in a file. This file can later be used by the -ClientList parameter
mentioned previously.

Answer y to continue the installation process.

If the update dbclients command was successful in distributing the software to the
client, it automatically runs the install dbext script on the client. If install dbext
has successfully completed, there will be a version file in directory

install path/share that contains the version of NetBackup for SAP on UNIX that
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was installed. The update dbclients command displays a note on whether the update
was successful for each client. When the update dbclients command has completed,
it displays a file name that contains a complete log of what happened for each client. If the
update failed for any client, the log file should be examined to determine the problem.

Local Installation of NetBackup for SAP on UNIX

During a local installation, the NetBackup for SAP on UNIX files are extracted and
installed. The local machine can be a client or a master server that also happens to be a
client.

Installation Requirements

*

The version of the NetBackup client and the version of NetBackup for SAP on UNIX
are the same (for example, 5.1).

The local machine must have adequate disk space.

Less than one megabyte of additional disk space is required in the
install path/netbackup directory. However, more disk space may be necessary
at run time.

NetBackup version 5.1 client software is installed and operational.

This also means that the install path/netbackup directory already exists.

Local Install Instructions

¥ To install NetBackup for SAP on UNIX to the local machine

1.

Log in as the root user on the machine.

If you are already logged in, but are not the root user, run the following command.
su - root

¢ Ifthe local machine is a client, go to step 3.

¢ Ifthe local machine is a server, go to step 2.

Make sure a valid license key for NetBackup for SAP on UNIX has been registered. In

a NetBackup server clustered environment, the license key must be registered on each
node. To view or add license keys, perform one of the following:

¢ Run the command
install path/netbackup/bin/admincmd/get license key.
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*

Open the NetBackup Administration Console and choose Help > License Keys.

3. Insert the CD-ROM into the drive.

4. Change the working directory to the CD-ROM directory.

cd

/CD_mount_point

5. Load and install the software by executing the install script.

Note It

is expected that the NetBackup version level (for example, 5.1) running on the

local machine matches the version level of the database agent being installed.

./install

a.

Select the NetBackup Database Agent Software option.
The following prompt appears:

Do you want to do a local installation? (y/n) [n]

Answer y.

You are presented with a menu of all database agents available on the CD-ROM.
Select the NetBackup for SAP option.

Enter g to quit selecting options.

A prompt appears asking if the list is correct.

Answer y.
The following actions occur:

¢ The version file, compressed tar fileand install dbext scriptare loaded to
directory install path/netbackup/dbext.

The install script automatically executes the install dbext script.

If install dbext has successfully completed, there will be a version file in
directory install path/share that contains the version of NetBackup for
SAP on UNIX that was installed and an installation timestamp.

Enter g to quit from the script.
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Linking NetBackup for SAP with backint

SAP requires that all SAP Tools be located in a predetermined directory. The directory
path is as follows:

/usr/sap/SID/SYS/exe/run

where SID is a unique name for an Oracle database instance. SID is also known as System
ID.

The directory should contain the following commands:
¢ Dbrarchive

¢ Dbrbackup

¢ Dbrconnect

¢ Dbrrestore

¢ Dbrtools

¢ sapdba

To follow SAP convention, you must link backint from the NetBackup install directory
to SAP’s tool directory. For example, if the Oracle instance name is CER, then the
following command must be executed:

ln -s install path/netbackup/bin/backint
/usr/sap/CER/SYS/exe/run/backint
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Before attempting to configure NetBackup for SAP on UNIX, complete the installation
procedure as described in the Installation chapter.

The following is the configuration procedure.

1. Configuring Media Using Media and Device Management
2. Setting the Maximum Jobs Per Client Property

3. Configuring a NetBackup Policy

4. Creating Scripts

5. Configuring the initSID.utl File

6. Configuring the initSID.sap File

7. Testing NetBackup for SAP on UNIX Configuration Settings

8. Testing Multiple Drives and Files
The following sections in this chapter describe each of these steps in detail.

To configure NetBackup for SAP on UNIX from a Windows NetBackup server, see
“Configuration Using the NetBackup Administration Console for Windows” on page 22.

To configure NetBackup for SAP on UNIX from a UNIX NetBackup server, see
“Configuration Using the NetBackup Administration Console for UNIX” on page 35.
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Configuration Using the NetBackup Administration
Console for Windows

Although the database agent is installed on the NetBackup client, some configuration
procedures are performed using the NetBackup Administration Console on the server.

These procedures include:

¢ Configuring media using Media and Device Management
¢ Setting the Maximum Jobs per Client property

¢ Configuring a NetBackup policy

¢ Testing NetBackup for SAP on UNIX configuration settings

See the next section for instructions on starting the NetBackup Administration Console.
¥ To launch the NetBackup Administration Console for Windows

1. Logon to the server as administrator.

2. Choose Start > Programs > VERITAS NetBackup > NetBackup Administration
Console.
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The NetBackup Administration Console is displayed.

]_?j dillweed { Enterprise Server) - NetBackup Administration Conso - |EI|1|

J File Edit Wew Actions Help ‘E

|1B-[E& % aX|sma a7 a B

dillweed

Ackiviby Monikar
(=) MetBackup Management

-] Reports (=] Getting Started

@ Palicies ‘#- Get step-by-step help setting up MetBackup,
-{=] Storage Units =

g Catalog

Host Properties

_
i)
EI@ Media and Device Manager ﬁ
o
=

Configure Storage Devices
Define robots and drives.

230 Device Monitar

BB Media Configure Yolumes
Devices Inventory roboks and define volumes For use in standalone drives.
- Access Management i)

Configure the Catalog Backup

Efu Specify how and when MNetBackup configuration and catalog information is ko be backed up.
Create a Backup Policy
Define schedules For backing up data on a single client or a set of clients,

- Import Images
J‘I This wizard will assist vou in stepping through an impart,

Far Help, press F1 [ LITL]] [Master Server: dilwesd [Connected s

Configuring Media Using Media and Device Management

Use the Media and Device Management (Media Manager) to configure media for a
NetBackup for SAP on UNIX configuration. Refer to the NetBackup Media Manager System
Administrator’s Guide for more information.

The number of volumes required will depend on the devices used, the size of the SAP
databases that you are backing up, and the frequency of backups.

Setting the Maximum Jobs Per Client Property

The Maximum jobs per client attribute value is figured with the following formula.
Maximum Jobs per Client = Number of Drives x Number of Policies

Where:

¢ Number of Drives is the number of concurrent bpbackup jobs. These jobs are defined
by the drive parameter in the initSID.utl file.
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¢ Number of Policies is the number of policies that may back up this client at the same
time. This number can be greater than one. For example, a client may be in two

policies in order to back up two different databases. These backup windows may
overlap.

Tip To avoid any problems, we recommend that you enter a high enough value for the
Maximum jobs per client property to meet the number of jobs executed by SAP.

V¥ To set the Maximum jobs per client property using the Windows console

1. Inthe left pane of the NetBackup Administration Console, expand Host Properties.

2. Select Master Server.

3. Inthe right pane, double-click on the server icon.

The Master Server Properties dialog is displayed.

4. Inthe Master Server Properties dialog, click Global Attributes.

x|
B Propetties Global Attributes Defaults |
& Global Attributes

Universal Settings Wakeup interval M aximum jobs per client:

2:::::|Son Periods |10 _:I minutes |1 _I;

----- B B andwidth Schedule backup attempts: I aximum backup copies:

..... Restore Failover |2 ﬁ tiies per (12 ﬁ hours |2 _|::'

----- B General Server

..... ‘@ Port Ranges Status report interval: ™ Compress catalog interval
Media I =1 I =|
! 24 _vlhours Aifter = days
Timeouts

By Client Attributes [ Cleanup

=] E_DM | ¥ Keeplogs [V Keep tiue image restoration [TIR] infarmation

ireveal

% Logaing For |23 _I; days For |1 _I; days

----- € Authorization

™ Delete vault logs ¥ Mave restore job from incomplete state to done state
[ Access Contral

- VERITAS Produc! After[a =] days Bt [T = days

Move backup job from incomplete state to done state:

After |3 _,::' haurs

Adminigtrator's e-mail address [separate multiple entries with commasz]:

<| [

QK I Cancel | Apply | Help

The default value is 1 for Maximum jobs per client.

5. Change the Maximum jobs per client value to 99.
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If you prefer to enter a lower value, calculate the value equal to the maximum number
of backups allowed per client using the formula provided above.

Configuring a NetBackup Policy

A NetBackup policy defines the backup criteria for a specific group of one or more clients.
These criteria include:

¢ storage unit and media to use

¢ backup schedules

¢ clients to be backed up

¢ script files to be executed on the clients

To use NetBackup for SAP on UNIX, at least one SAP policy with the appropriate
schedules needs to be defined. A configuration can have a single policy that includes all
clients or there can be many policies, some of which include only one client.

Most requirements for SAP policies are the same as for file system backups. In addition to
the attributes described here, there are other attributes for a policy to consider. Refer to the
NetBackup System Administrator’s Guide for Windows, Volume | or NetBackup System
Administrator’s Guide for UNIX, Volume | for detailed configuration instructions and
information on all the attributes available.

Adding New Policies

Use this procedure when configuring a policy from a Windows server or from a
NetBackup Remote Administration Console host.

V¥ To add a new policy

Note This policy name can be specified in the initSID.utl file on the client.

1. Logon to the server as administrator.
2. Start the NetBackup Administration Console.

3. If your site has more than one master server, choose the one where you want to add
the policy.

4. Inthe left pane, right-click Policies and choose New Policy.
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The Add a New Policy dialog is displayed.

Add a New Policy =

Folicy name:

™ Use Backup Policy Configuration ‘wizard.

()8 I Cancel |

a. Inthe Policy name box, type a unique name for the new policy.

b. Choose whether to use the wizard for configuring the policy. The wizard guides
you through most of the setup process and simplifies it by automatically choosing
default values that are good for most configurations. If necessary, you can change
the defaults later by editing the policy. You will need to manually add entries to
the Backup Selections list after completing the wizard.

¢ To use the wizard, select the Use Backup Policy Configuration Wizard box
and click OK. The wizard starts and you create the policy by following the
prompts. When prompted, select the SAP policy type.

Note The SAP policy type will not appear in the drop-down list unless your server has a
license key for NetBackup for SAP on UNIX.

¢ If you require more control over the settings than the wizard provides, then
do not select the Use Backup Policy Configuration Wizard box and proceed
to step 5.

5. Click OK.
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A dialog is displayed in which you can specify the general attributes for the policy.

Change Policy - test 21l
Attributes |@ Schedulesl Elientsl 3 Selectionsl
¥ Active. Go into effect at:
| am1/2003 =Hl12:4451 P =
Destination ™ Backup Network Drives
Policy storage unit: X
r Crogs mount points
I Any Available j X X X
™ Collect true image restore information
Palicy volume poal: : .
i P ™| with rmoye detection
INetBackup j [Required for synthetic backups)
™ Checkpoint restart every: " Compression
ID _I; minutes I™ Encmption
[ Limit jobs per policy: ™ Collect disaster recovery information
_:| [~ Allow multiple data streams
Job priority: _ . Keyword phrase: [optional]
0 <1 [higher number iz
=l qgreater priority] I

—Advanced Client
™| Perform black level incremental backups

™ Perfarmsnapshot backups Ldvanced Shapshot Dptions...
™| Retain snapshots for instant recoyvery

™| Perfarm offiost backup
1 sz altemate clisnt 1 Use data mover
I INetBackup Media Server j

QK I Cancel | Help |

6. From the Policy Type box, select the SAP policy type.

7. Complete the entries on the Attributes tab as explained in “Description of
Attributes.”
8. Add other policy information:
¢ To add schedules, see “Adding New Schedules.”
¢ To add clients, see “Adding Clients to a Policy.”
¢ To add scripts to the Backup Selections list, see “Specifying the List of Backup
Selections.”

9. Click OK. The new policy is created.
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v

Description of Attributes

With a few exceptions, NetBackup manages a database backup like a file system backup.
Policy attributes that are different for SAP backups are explained below.

Your other policy attributes will vary according to your specific backup strategy and
system configuration. Consult the NetBackup System Administrator’s Guide for Windows,
Volume | or NetBackup System Administrator’s Guide for UNIX, Volume | for detailed
explanations of the policy attributes.

Description of Policy Attributes

Attribute Description

Policy type Determines the type of clients that can be in the policy and in some cases
the types of backups that can be performed on those clients.
To use NetBackup for SAP on UNIX, you must have defined at least one
SAP policy.

Keyword phraseto  For NetBackup for SAP on UNIX, the keyword phrase entry is ignored.
associate with the
backup

Adding New Schedules

Each policy has its own set of schedules. These schedules control initiation of automatic
backups and also specify when user operations can be initiated.

A server-directed, scheduled SAP backup requires an Application Backup schedule,
which is created automatically when you create a SAP policy. The Application Backup
schedule is used to initiate and manage the backup operation. You also need one or more
Automatic Backup schedules, if you plan to have NetBackup perform automatic,
scheduled backups.

The following procedures explain how to configure the required schedule types, and how
to add new schedules. The procedures start on the Policy dialog. To see the Policy dialog,
double-click the policy name in the Policies list of the NetBackup Administration Console.
To configure an Application Backup schedule

1. Onthe Policy dialog, click the Schedules tab.

2. Double-click on the schedule named Default-Application-Backup.
A dialog is displayed.
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All SAP database operations are performed through NetBackup for SAP on UNIX
using an Application Backup schedule. This includes those backups started
automatically.

You must configure an Application Backup schedule for each SAP policy you create. If
you do not do this, you will not be able to perform a backup. To help satisfy this
requirement, an Application Backup schedule named Default-Application-Backup is
automatically created when you configure a new SAP policy.

Specify the other properties for the schedule as explained in “Schedule Properties.”

The backup window for an Application Backup schedule must encompass the time
period during which all NetBackup jobs, scheduled and unscheduled, will occur. This
is necessary because the Application Backup schedule starts processes that are
required for all NetBackup for SAP on UNIX backups, including those started
automatically.

For example, assume that you:

& expect users to perform NetBackup operations during business hours, 0800 to
1300.

¢ configured automatic backups to start between 1800 and 2200.

The Application Backup schedule must have a start time of 0800 and a duration of 14
hours.

Example Settings for an Application Backup schedule

Type of Backup | Schedule settings | Description Settings
Application Retention The length of time backup images 2 weeks
Backup are stored.

Backup Window The time during which a NetBackup | Sunday through Saturday
operation can be performed. 00:00:01 - 23:59:59

Note The Application Backup schedule name can be specified in the initSID.utl file

on the client.

Tip

Set the time period for the Application Backup schedule for 24 hours per day, seven
days per week. This ensures that your NetBackup for SAP on UNIX operations are
never locked out due to the Application Backup schedule.
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V¥ To configure an automatic backup schedule

1. On the Policy dialog, click the Schedules tab.

2. Click New.

A dialog is displayed. The title bar shows the name of the policy to which you are
adding the schedules.

Change Schedule - Policy test

&y Attibutes |% Start W'indowl @& Exclude Datesl

2|

Mame: — Destination:
|| I~ | Instant recoveny backups to disk anly
Tvpe of backup: I” Multiple copies Canfigure... |
IFuII Backup j ™ Ovenide policy storage unit:
I~ | Syrthetic backup I j
Sl e ™ Ovenide policy volurme pool:
MetBackup -
" Calendar I J
Eetention:
™| Retries allowed after munday S
|2 weeks [level 1] 'l
¥ Erequency: Media multiplexing
|1 3: ek, vl =
eeks I 1 _I:
QK I Cancel Help

3. Specify a unique name for the schedule.

4. Select the Type of backup.

For information on the types of backups available for this policy, see “Types of
Backups.”

Refer to the following table for example settings for an Automatic Backup schedule.

Example Settings for an Automatic Backup Schedule

Type of Backup Schedule settings | Description Settings
Automatic Backup | Retention The length of time to store the 2 weeks
record of a backup.
Frequency Frequency determines how often | every week
a backup should be performed
Backup Window The time during which a Sunday, 18:00:00 - 22:00:00

NetBackup operation can be
performed.
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5. Specify the other properties for the schedule as explained in “Schedule Properties.”

6. Click OK.

Types of Backups

Description of Backup Types for SAP

Application Backup The Application Backup schedule enables user-controlled NetBackup
operations performed on the client. At least one Application Backup
schedule type must be configured for each SAP policy. The
Default-Application-Backup schedule is automatically configured as an
Application Backup schedule.

Automatic Backup  An Automatic Backup schedule specifies the dates and times when
NetBackup will automatically start backups by running the SAP scripts in
the order that they appear in the file list. If there is more than one client in
the SAP policy, the SAP scripts are executed on each client.

Schedule Properties

Some of the schedule properties have a different meaning for database backups than for a
regular file system backup. These properties are explained in the following table.

Other schedule properties vary according to your specific backup strategy and system
configuration. Consult the NetBackup System Administrator’s Guide for Windows, Volume | or
NetBackup System Administrator’s Guide for UNIX, Volume I for detailed explanations of the
schedule properties.

Description of Schedule Properties

Property Description

Type of backup Specifies the type of backup that this schedule will control. The selection list
shows only the backup types that apply to the policy you are configuring.

For more information see the following section “Types of Backups.”
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Description of Schedule Properties (continued)

Property

Description

Frequency

Calendar

Retention

Multiple copies

This setting is used only for scheduled backups, and not for user-directed
backups. Frequency specifies the period of time that will elapse until the
next backup operation can begin on this schedule. For example, if the
frequency is seven days and a successful backup occurs on Wednesday, the
next full backup will not occur until the following Wednesday. Normally,
incremental backups will have a shorter frequency than full backups.

This setting is used only for scheduled backups, and not for user-directed
backups. The Calendar option allows you to schedule backup operations
based on specific dates, recurring week days, or recurring days of the
month.

Frequency based scheduling

The retention period for an Application Backup schedule refers to the
length of time that NetBackup keeps backup images.

The retention period for an Automatic Backup schedule controls how long
NetBackup keeps records of when scheduled backups have occurred.

The NetBackup scheduler compares the latest record to the frequency to
determine whether a backup is due. This means that if you set the retention
period to expire the record too early, the scheduled backup frequency will be
unpredictable. However, if you set the retention period to be longer than
necessary, the NetBackup catalog will accumulate unnecessary records.
Therefore, set a retention period that is longer than the frequency setting for the
schedule.

For example, if the frequency setting is set to one week, set the retention
period to be more than one week.

Calendar based scheduling

The retention period for an Application Backup schedule refers to the length
of time that NetBackup keeps backup images.

The retention period for an Automatic Backup schedule controls how long

NetBackup keeps records of when scheduled backups have occurred.
However, this setting is not significant for calendar based scheduling.

If you are licensed for the Inline Tape Copy feature and wish to specify
multiple copies for your SAP policy, configure Multiple copies on the
Application Backup schedule.
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Adding Clients to a Policy

The client list is the list of clients on which your SAP scripts are run during an automatic
backup. A NetBackup client must be in at least one policy but can be in more than one.

This procedure starts in the Policy dialog. To see the Policy dialog, double-click the policy
name in the Policies list in the NetBackup Administration Console.

Requirements for clients

The following software must be installed on the client:
¢ SAP

¢ NetBackup client or server

¢ NetBackup for SAP on UNIX
.

the backup or restore script(s)
V¥ To add clients to a policy
1. Inthe Policy dialog, click the Clients tab.
2. Click New.

3. Enter the name of the client you want to add.
¢ Type the name into the client list and click OK.

If NetBackup cannot detect the hardware and operating system, a dialog will be
displayed so you can specify this information.

OR
,El,| ¢ Click the Browse for Computer button to choose the client from the network:

4. To add another client, repeat step 2 and step 3. If this is the last client, click OK to
close the dialog.

Specifying the List of Backup Selections

The Backup Selections list in a database policy has a different meaning than for
non-database policies. For example, in a Standard policy, the list contains files and
directories to be backed up. In a database policy, you specify scripts to be run.
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sl

Add scripts only if you are setting up a policy for automatic scheduling. All scripts listed
in the Backup Selections list will be executed for the Automatic Backup schedules, as
specified under the Schedules tab, and manual backups. NetBackup will start backups
according to the order that scripts appear in the Backup Selections list.

The following procedure starts in the Policy dialog. To see the Policy dialog, double-click
the policy name in the Policies list in the NetBackup Administration Console.

To add scripts to the Backup Selections list

1.

2.

In the Policy dialog, click the Backup Selections tab.
Click New.

Enter the name of the selection.
¢ Type the name of the script.
Be sure to specify the full pathname when listing SAP scripts. For example:
install path/netbackup/ext/db ext/sap/scripts/
OR
¢ Click the Remote Folder button.

The Browse window is displayed. Navigate to the script file and select the file.
Click OK.

Refer to “Instructions for Modifying Scripts” on page 49 for details.

Be sure that the SAP scripts listed here are installed on each client in the Client list.

Click OK.
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Configuration Using the NetBackup Administration
Console for UNIX

Although the database agent is installed on the NetBackup client, some configuration
procedures are performed using the NetBackup Administration Console on the server.

These procedures include:

*

*

*

*

Configuring media using Media and Device Management
Setting the Maximum Jobs per Client property
Configuring a NetBackup policy

Testing NetBackup for SAP on UNIX configuration settings

See the next section for instructions on starting the NetBackup Administration Console.

¥ To launch the NetBackup Administration Console for UNIX

1.

2.

3.

Log onto the UNIX server as root.

Start the NetBackup Administration Console by executing:
install path/netbackup/bin/jnbSA &

The login dialog is displayed.

[FNetBackup Administration Cansole -0l x|

VERITAS NetBackup™
)
.q.k_' You may inister NetBackup on any

host. To login, enter the username and password
for the specified NetBackup host.

Host name:

| hagar ‘ - |

User name:

|raat ‘V|

Passwaord:
[ |

| Login H Cancel H Help |

Type the name of the master server where you initially want to manage NetBackup.
You can specify any NetBackup master server. Indicate the User and Password.
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4. Click Login. The NetBackup Administration Console is displayed.

Edhagar (Enterprise Server) - NetBackup Administration Console =lol x|
VERITAS NetBackup™
File View Help
8|« = B &y
hagar (Master Server) :
B hagar {Master Servery : Getting Started
B} Backup, Archive, and Restore : . Get step-hy-step help setting up MetBackup from startto
Activity Monitor ] == -
@ MetBackup Management : L
@ =] Reports
™ Falicies : A Caonfigure Storage Devices

@ (= Starage Units
Q Catalog
@ &8 Host Properties :
@ @ Media and Device Management |
=l Device Monitar :

Define rohats and drives

Configure Volumes
@ Media Inventory rohots and define volumes for use in standalone
@ |5 Devices drives.

@Access anagement
&g vault Management
@ Filesystem Analyzer Configure the Catalog Backup
Specify how and when MetBackup configuration and catalog
information is to he backed up.

Create a Backup Policy
Define schedules for backing up data on a single clientor a
set of clients

P ER >

Configuring Media Using Media and Device Management

Use the Media and Device Management (Media Manager) to configure media for a

NetBackup for SAP on UNIX configuration. Refer to the NetBackup Media Manager System
Administrator’s Guide for more information.

The number of volumes required will depend on the devices used, the size of the SAP
databases that you are backing up, and the frequency of backups.

Setting the Maximum Jobs Per Client Property

The Maximum jobs per client attribute value is figured with the following formula.
Maximum Jobs per Client = Number of Drives x Number of Policies

Where:

¢ Number of Drives is the number of concurrent bpbackup jobs. These jobs are defined
by the drive parameter in the initSID.utl file.
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¢ Number of Policies is the number of policies that may back up this client at the same
time. This number can be greater than one. For example, a client may be in two
policies in order to back up two different databases. These backup windows may
overlap.

Tip To avoid any problems, we recommend that you enter a high enough value for the
Maximum jobs per client property to meet the number of jobs executed by SAP.

V¥ To set the Maximum jobs per client property using the NetBackup Administration
Console for UNIX

1. Inthe left pane of the NetBackup Administration Console, expand Host Properties.
Select Master Servers.

2. Inthe right pane, double-click on the server icon. Click Global Attributes.
The Master Server Properties dialog is displayed.

i | Master Server Properties: hagar x|
et ' |_otauts |
" Defaults
Tl | Clobal Attributes &

{@ Universal Settings

% Wakeup liﬂtenral: Maximuml_juhs per client:

a :ee:\?;rt;m Ferinds Jlﬁ TS JJ

m&; Bandwidth Schedule backup | Mazimum backup copies:

52 Restore Failover | | 2[Z wiesper| 15[Hhours | 2|

B General Server

E Fort Ranges Status report interval: Compress catalog interval
hedia (=

g Timeouts AE hours

Bl Client Attributes Cleanup

& GDM

Q Firawall + Keep logs + Keep true image restoration (TIR) information

By Logaing For | %days For 1 Ilelayvs

ﬁ\ Autharization
@ Access Control + Delete vault logs ~ Move restore job from incomplete state to done state

[ unx server Atter 30% days After JE days

@ = VERITAS Products

Move backup job from incomplete state to done state:

After 3 % hours

Administrator e-mail address:

[ ok || cancel || appy || Hew

The default value is 1 for Maximum jobs per client.

3. Change the Maximum jobs per client value to 99.
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If you prefer to enter a lower value, calculate the value equal to the maximum number
of backups allowed per client using the formula provided above.

Configuring a NetBackup Policy

A NetBackup policy defines the backup criteria for a specific group of one or more clients.
These criteria include:

¢ storage unit and media to use

¢ backup schedules

¢ clients to be backed up

¢ script files to be executed on the clients

To use NetBackup for SAP on UNIX, at least one SAP policy with the appropriate
schedules needs to be defined. A configuration can have a single policy that includes all
clients or there can be many policies, some of which include only one client.

Most requirements for SAP policies are the same as for file system backups. In addition to
the attributes described here, there are other attributes for a policy to consider. Refer to the
NetBackup System Administrator’s Guide for Windows, Volume | or NetBackup System
Administrator’s Guide for UNIX, Volume | for detailed configuration instructions and
information on all the attributes available.

Adding New Policies

Use this procedure when configuring a policy from a UNIX server.

To add a new policy

Note This policy name can be specified in the initSID.utl file on the client.

1. Log onto the server as root.
2. Start the NetBackup Administration Console.

3. [Ifyour site has more than one master server, choose the one to which you want to add
the policy.

4. In the left pane, click on Policies. The right pane splits into an All Policies pane and a
details pane.

5. Inthe All Policies pane, right-click on the Master Server, and click New.

NetBackup for SAP System Administrator’s Guide for UNIX



Configuration Using the NetBackup Administration Console for UNIX

The Add a New Policy dialog is displayed.

ﬂndd a New Policy =

Policy name:

[C] Use add policy wizard.

| OK H Cancel |

a. Inthe Policy name box, type a unique name for the new policy.

b. Choose whether to use the wizard for configuring the policy. The wizard guides
you through most of the setup process and simplifies it by automatically choosing
default values that are good for most configurations. If necessary, you can change
the defaults later by editing the policy. You will need to manually add entries to
the Backup Selections list after completing the wizard.

¢ To use the wizard, select the Use add policy wizard box and click OK. The
wizard starts and you create the policy by following the prompts. When
prompted, select the SAP policy type.

Note The SAP policy type will not appear in the drop-down list unless your server has a
license key for NetBackup for SAP on UNIX.

¢ If you require more control over the settings than the wizard provides, do not
select the Use add policy wizard box and proceed to step 6.

6. Click OK.
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10.

A dialog is displayed in which you can specify the general attributes for the policy.

ﬂthange Policy - test

x|

5] senver: Ihagar

Attributes

Policy type:
| Standard
Nestinati

Policy storage unit:
| Any_available

Policy volume poaol:
|NetBackup

[_] Take checkpoints every:

[Z] Limit jobs per policy:

Joh priority:

] D {higher number is greater

priority)

[v] Active. Go into effect at:
[140m42  [Elosnarons|+E
[_] Follow NFS

[C] Cross mount points
[_] Collect true image restore information
[] with move detection

{Required for synthetic backups)
[C] Compression
] Encryption
[] Collect disaster recovery information
[_] Allow multiple data streams

Key d phrase

~Advanced Client
[] Perform block level incremental backups
[] Perform snapshaot backups
[] Retain snapshaots for instant recovery
[] Perform offhost backup
) Use alternate client

| Advanced Snapshot Options... |

) Use data mover

- |

‘ Apply

o o | [ |

From the Policy type box, select the SAP policy type.

Complete the entries on the Attributes tab as explained in “Description of Attributes

L1

and click Apply to save the attribute entries.

Add other policy information:

¢ To add schedules, see “Adding New Schedules.”

¢ To add clients, see “Adding Clients to a Policy.”

¢ To add scripts, see “Specifying the List of Backup Selections.”

Click Apply. The new policy is created.
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Description of Attributes

With a few exceptions, NetBackup manages a database backup like a file system backup.
Policy attributes that are different for SAP backups are explained below.

Your other policy attributes will vary according to your specific backup strategy and
system configuration. Consult the NetBackup System Administrator’s Guide for Windows,
Volume | or NetBackup System Administrator’s Guide for UNIX, Volume | for detailed
explanations of the policy attributes.

Description of Policy Attributes

Attribute Description

Policy type Determines the type of clients that can be in the policy and in some cases
the types of backups that can be performed on those clients.
To use NetBackup for SAP on UNIX, you must have defined at least one
SAP policy.

Keyword phraseto  For NetBackup for SAP on UNIX, the keyword phrase entry is ignored.
associate with the
backup

Adding New Schedules

Each policy has its own set of schedules. These schedules control initiation of automatic
backups and also specify when user operations can be initiated.

A server-directed, scheduled SAP backup requires at least two specific schedule types: an
Application Backup schedule and an Automatic Backup schedule. You can also create
additional schedules.

The following procedures explain how to configure the required schedule types, and how
to add other new schedules. The procedures start from the Policy dialog. To see the Policy
dialog, double click the policy in the policy list in the left pane of the NetBackup
Administration Console.

¥ To configure an Application Backup schedule
1. Inthe Policy dialog, click the Schedules tab.

2. Inthe Schedule list, double-click on the schedule named
Default-Application-Backup.

A dialog is displayed. The title bar shows the name of the policy to which you are
adding the schedule.
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All SAP database operations are performed through NetBackup for SAP on UNIX
using an Application Backup schedule. This includes those backups started
automatically.

You must configure an Application Backup schedule for each SAP policy you create. If
you do not do this, you will not be able to perform a backup. To help satisfy this
requirement, an Application Backup schedule named Default-Application-Backup is
automatically created when you configure a new SAP policy.

Specify the other properties for the schedule as explained in “Schedule Properties.”

The backup window for an Application Backup schedule must encompass the time
period during which all NetBackup jobs, scheduled and unscheduled, will occur. This
is necessary because the Application Backup schedule starts processes that are
required for all NetBackup for SAP on UNIX backups, including those started
automatically.

For example, assume that you:

& expect users to perform NetBackup operations during business hours, 0800 to
1300.

¢ configured automatic backups to start between 1800 and 2200.

The Application Backup schedule must have a start time of 0800 and a duration of 14
hours.

Tip

Set the time period for the Application Backup schedule for 24 hours per day, seven
days per week. This ensures that your NetBackup for SAP on UNIX operations are
never locked out due to the Application Backup schedule.

Example Settings

for an Application Backup schedule

Type of Backup | Schedule settings | Description Settings
Application Retention The length of time backup images 2 weeks
Backup are stored.

Backup Window The time during which a NetBackup | Sunday through Saturday
operation can be performed. 00:00:01 - 23:59:59

Note The Application Backup schedule name can be specified in the initSID.utl file

on the client.
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V¥ To configure an automatic backup schedule
1. Inthe Policy dialog, click the Schedules tab.
2. Click New.

A dialog is displayed. The title bar shows the name of the policy to which you are

adding the schedules.

[Fladd schedule - Policy test

5 server: Ihagar

% nributes |65

Name: ~Di
‘ [_] Multiple copies
Type of hackup: [ Owerride policy storage unit;
Full Backup 4 ‘ |A ; ‘ |
ny_availabl -
[] Symthetic hackup
[ Disk-onty backup [C] Owverride policy volume pool:
|NetBackup ‘ - |
rSchedule type:
) Calendar R
[] Retries allowed after runday | 2 weeks % |
@) Frequency: Media multiplexing:
|1 |ZI weeks 7 | |1 ﬂ

| Add || 0K || Close || Help |

3. Specify a unique name for the schedule.

4. Select the Type of Backup.

For information on the types of backups available for this policy, see “Types of
Backups.”
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Refer to the following tables for example settings for an Automatic Backup schedule.

Example Settings for a Automatic Backup Schedule

Type of Backup Schedule settings | Description Settings
Automatic Backup | Retention The length of time to store the 2 weeks
record of a backup.
Frequency Frequency determines how often | every week
a backup should be performed
Backup Window The time during which a Sunday, 18:00:00 - 22:00:00
NetBackup operation can be
performed.

5. Specify the other properties for the schedule as explained in “Schedule Properties.

6. If thisis the last schedule, click OK.

Types of Backups

Description of Backup Types for SAP

Application Backup The Application Backup schedule enables user-controlled NetBackup
operations performed on the client. At least one Application Backup
schedule type must be configured for each SAP policy. The
Default-Application-Backup schedule is automatically configured as an
Application Backup schedule.

Automatic Backup  An Automatic Backup schedule specifies the dates and times when
NetBackup will automatically start backups by running the SAP scripts in
the order that they appear in the file list. If there is more than one client in
the SAP policy, the SAP scripts are executed on each client.

Schedule Properties

Some of the schedule properties have a different meaning for database backups than for a
regular file system backup. These properties are explained in the following table.
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Other schedule properties vary according to your specific backup strategy and system
configuration. Consult the NetBackup System Administrator’s Guide for Windows, Volume | or
NetBackup System Administrator’s Guide for UNIX, Volume | for detailed explanations of the

schedule properties.

Description of Schedule Properties

Property

Description

Type of backup

Frequency

Calendar

Retention

Specifies the type of backup that this schedule will control. The selection list
shows only the backup types that apply to the policy you are configuring.

For more information see the following section “Types of Backups.”

This setting is used only for scheduled backups, and not for user-directed
backups. Frequency specifies the period of time that will elapse until the
next backup operation can begin on this schedule. For example, if the
frequency is seven days and a successful backup occurs on Wednesday, the
next full backup will not occur until the following Wednesday. Normally,
incremental backups will have a shorter frequency than full backups.

This setting is used only for scheduled backups, and not for user-directed
backups. The Calendar option allows you to schedule backup operations
based on specific dates, recurring week days, or recurring days of the
month.

Frequency based scheduling

The retention period for an Application Backup schedule refers to the
length of time that NetBackup keeps backup images.

The retention period for an Automatic Backup schedule controls how long
NetBackup keeps records of when scheduled backups have occurred.

The NetBackup scheduler compares the latest record to the frequency to
determine whether a backup is due. This means that if you set the retention
period to expire the record too early, the scheduled backup frequency will be
unpredictable. However, if you set the retention period to be longer than
necessary, the NetBackup catalog will accumulate unnecessary records.
Therefore, set a retention period that is longer than the frequency setting for the
schedule.

For example, if the frequency setting is set to one week, set the retention
period to be more than one week.

Calendar based scheduling

The retention period for an Application Backup schedule refers to the length
of time that NetBackup keeps backup images.

The retention period for an Automatic Backup schedule controls how long
NetBackup keeps records of when scheduled backups have occurred.
However, this setting is not significant for calendar based scheduling.
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v

Description of Schedule Properties (continued)

Property Description

Multiple copies If you are licensed for the Inline Tape Copy feature and wish to specify
multiple copies for your SAP policy, configure Multiple copies on the
Application Backup schedule.

Adding Clients to a Policy

The client list is the list of clients on which your NetBackup for SAP on UNIX backups will
be performed. A NetBackup client must be in at least one policy but can be in more than
one.

This procedure starts from the Policy dialog. To see the Policy dialog, double-click the
policy in the policy list in the left pane of the NetBackup Administration Console.

Requirements for clients

The following software must be installed on the client;
¢ SAP

¢ NetBackup client or server

¢ NetBackup for SAP on UNIX
.

the backup or restore script(s)
To add clients to a policy
1. Inthe Policy dialog, click the Clients tab.

2. On the Clients tab, click New.
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The Add Client dialog is displayed. The title bar shows the name of the policy where
you are adding clients.

[l add client - Policy test |

5] senver: |hagar

Client name:
| | OK

Hardware and operating system: Close
| NDMP, NDMP -]
Help

3. Inthe Client name text box, type the name of the client that you are adding.
4. Choose the Hardware and operating system type and click Add.

5. Ifthisisthe last client, click OK. If you are going to add more clients, repeat step 3 and
step 4.

Specifying the List of Backup Selections

The Backup Selections list in a database policy has a different meaning than for
non-database policies. For example, in a Standard policy, the list contains files and
directories to be backed up. In a database policy, the list contains script.

Add scripts only if you are setting up a policy for automatic scheduling. All scripts listed
in the Backup Selections list will be executed for the Automatic Backup schedules as
specified under the Schedules tab. NetBackup will start backups by running the scripts in
the order that they appear in the Backup Selections list.

The following procedure starts from the Policy dialog. To see the Policy dialog,
double-click the policy in the Policies list in the NetBackup Administration Console.

V¥ To add scripts to the Backup Selections List

1. Inthe Policy dialog, click the Backup Selections tab.

2. Click New.
———
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A dialog is displayed. The title bar shows the name of the policy to which you are
adding the scripts.

ﬂndd Backup Selection - Policy test =

‘ 5] senver:

hagar ‘

Construct a list of scripts to add to the selection list.

Script:

List of scripts to add to the selection list:

| »

-

1] []

| OK H Cancel H Help |

3. Type the name of the SAP script.
Be sure to specify the full pathname when listing SAP scripts. For example:
install path/netbackup/ext/db ext/sap/scripts/
Be sure that the SAP scripts listed here are installed on each client in the Client list.

Refer to “Creating Scripts” on page 49 for details on creating scripts.
4. Click Add.
5. To add more scripts, repeat step 3 and step 4.

6. When you are finished adding backup selections, click OK.
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Creating Scripts

The following example scripts were included with the NetBackup for SAP on UNIX
installation:

sap_offline backup
sap_online_ backup
sap_redo_log backup

These scripts were installed in the following directory:
install_path/netbackup/ext/db ext/sap/scripts/
Be sure to modify these scripts for your environment.

Although each script can have multiple SAP Tools operations, a separate script is required
for each type of operation. For example, you need separate scripts for backups and
restores.

Caution Always specify the correct script when configuring automatic backups or when
starting operations through NetBackup. NetBackup for SAP on UNIX will not
generate an error if a restore script is used for a backup operation or a backup
script is used for a restore operation.

Instructions for Modifying Scripts

Note If you do not include an su - user (user is the SAP administrator account) in your
scripts, they will not run with the proper permissions and environmental variables.
The result will be problems with your database backups or restores.

1. If necessary, copy the example scripts to a different directory on your client. SAP
scripts can be located anywhere on the client.

2. Set the access permissions of these scripts to 775.

chmod 775 <script_names>
3. Modify the sap_offline backup script.

a. Use atext editor to open the sap _offline backup script. The following
example uses the vi text editor.

vi sap offline backup
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The following will appeatr.

#!/bin/sh

#This environment variable are created by Netbackup (bphdb)

#

echo "SAP SCHEDULED = $SAP_SCHEDULED"
echo "SAP _USER_INITIATED = $SAP _USER_INITIATED"

echo "SAP_SERVER = $SAP_SERVER"
echo "SAP_POLICY = $SAP_ POLICY"

RETURN_STATUS=0
CMD_LINE=""
#

# If SAP_SERVER exists then export
#

if [ -n "$SAP_SERVER" ]
then
CMD_LINE="$CMD_LINE export
fi
#

# If SAP_POLICY exists then export

if [ -n "$SAP_POLICY" ]
then
CMD_LINE="$CMD_LINE export
fi
#
# Full offline backup
#

CMD_LINE="$CMD_LINE brbackup -c -d

#

# The username on the "su" command
# user name.

#

echo "Execute $CMD_LINE"

su - orasap -c "S$CMD_ LINE"

RETURN_STATUS=$?

exit $RETURN_STATUS

it to make it available to backint

SAP_SERVER=$SAP_SERVER;"

it to make it available to backint

SAP_POLICY=$SAP_POLICY;"

util file -t offline -m all"

needs to be replaced with the correct

b. Follow the instructions in the sap offline backup script.
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Note Test the scripts you just created. Refer to “Testing NetBackup for SAP on UNIX
Configuration Settings” on page 59.

Script Parameters

A number of parameters are necessary in SAP scripts to enable SAP utilities to perform
backup and restore operations. The parameters can come from one of three sources:

¢ Environmental Variables
& Parameter File (initSID.sap & initSID.utl), where SID is the instance.
¢ NetBackup Configuration File (bp . conf)

The different parameter sources can be used to create different SAP scripts to perform
different database backup/restore tasks. For example, the $SAP_POLICY can be defined
in an SAP script to perform different types of backups (on-line, off-line, or redo logs).

It is also important to note that some environmental variables are created locally when an
SAP script is executed through NetBackup’s Automatic Scheduler.

When NetBackup’s Automatic Scheduler calls an SAP script, the following environmental
variables are created.

$SAP_POLICY Name of the NetBackup SAP policy.
$SAP_SERVER Name of the NetBackup server.

$SAP_SCHEDULED Set to 1 if this is an automatic backup (Scheduled SAP).

$SAP_USER_INITIATED Set to 1 if this is a user-initiated backup (SAP backup is started from the
master server)

When an SAP script is started from the Java interface, all of the same variables are created
except for $SAP_POLICY variable.
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Example 1: Full Off-line Database Backup
Sample SAP script location:
install path/netbackup/ext/db ext/sap/scripts/sap offline backup

The following SAP script uses an su command to log into an SAP administrator user
account from root. The su command executes a brbackup command to perform an
off-line database backup. Use the export command to make $SAP_SERVER and
$SAP_POLICY, which are created by bphdb in root, available to the NetBackup for SAP on
UNIX backint interface process.

#!/bin/sh

echo "SAP SCHEDULED = $SAP_SCHEDULED”

echo "SAP USER INITIATED = $SAP_USER_INITIATED"
echo "SAP SERVER = $SAP_SERVER"

echo "SAP POLICY = $SAP_POLICY"

RETURN_ STATUS=0

CMD_ LINE=""
if [ -n "$SAP_SERVER" 1
then
CMD_LINE:"SCMD_LINE export SAP_SERVER=$SAP_SERVER;”
fi
if [ -n "$SAP_POLICY" ]
then
CMD_LINE="$CMD_LINE export SAP_POLICY=$SAP_POLICY;”
fi

CMD LINE="$CMD LINE brbackup -c -d util file -t offline -m all"
echo "Execute $CMD LINE"

su - orasap -c¢ "$CMD LINE"

RETURN_ STATUS=$?

exit $RETURN_STATUS

Note The above SAP script may need to be modified to work correctly. Make sure the su
command logs into the correct user, and the desired environmental variables are
being exported.
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Example 2: Full On-line Database Backup

Sample SAP script location:

install path/netbackup/ext/db ext/sap/scripts/sap online backup

The SAP script contains instructions to start the brbackup and brarchive commands.

#!/bin/sh

echo "SAP_SCHEDULED = $SAP_SCHEDULED"

echo "SAP USER_INITIATED = $SAP_USER_INITIATED"
echo "SAP_SERVER = $SAP_SERVER"

echo "SAP_POLICY = $SAP_POLICY"

RETURN_STATUS=0

EX_CMD_LINE=""

if [ -n "$SAP_SERVER" ]
then

EX_CMD_LINE="$CMD_LINE export SAP_SERVER=$SAP_SERVER;"
fi
if [ -n ”$SAP_POLICY" ]
then

EX CMD LINE="$CMD LINE export SAP POLICY=$SAP POLICY;"
fi

CMD_LINE="$EX CMD_LINE brbackup -c -d util_file online -t online -m all"
echo "Execute $CMD_LINE"
su - orasap -c "S$CMD_LINE"
RETURN_STATUS=$?
if [ SRETURN_STATUS -eq 0 ]
then
CMD_LINE="S$EX CMD_LINE brarchive -c -d util_ file -sd"
echo "Execute $CMD_LINE"
su - orasap -c "S$CMD_LINE"
RETURN_STATUS=$?
fi
exit $RETURN_STATUS
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Example 3: Backup of Offline Redo Log Files

Sample SAP script location:

install path/netbackup/ext/db ext/sap/scripts/sap redo log_ backup
This SAP script contains instructions to start the brarchive command:

#!/bin/sh

echo "SAP SCHEDULED = $SAP_SCHEDULED"

echo "SAP USER INITIATED = $SAP_USER_INITIATED"
echo "SAP SERVER $SAP_SERVER"

echo "SAP POLICY = $SAP_POLICY"

RETURN_ STATUS=0

CMD_ LINE=""
if [ -n "$SAP_SERVER" 1
then
CMD_LINE:"SCMD_LINE export SAP_SERVER=$SAP_SERVER;”
fi
if [ -n "$SAP_POLICY" ]
then
CMD_LINE="$CMD_LINE export SAP_POLICY=$SAP_POLICY;"
fi

CMD LINE="$CMD LINE brarchive -c -d util file -sd"
echo "Execute $CMD LINE"

su - orasap -c¢ "$CMD LINE"

RETURN_STATUS=$?

exit $RETURN_STATUS
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Configuring the initSID.utl File

Configure the NetBackup for SAP on UNIX by modifying the backint -p par fileor
the initSID.utl file. These are text files submitted to the NetBackup for SAP on UNIX
backint interface by SAP Tools with the -p par_file parameter. The name of the par_file
is specified on the util_par_file parameter in the profile file (see “Configuring the
initSID.sap File” on page 57). SAP Tools determines the name of the par_file through the
profile file.

1. Create a Parameter File.

Copy the parameter file from the NetBackup directory to the
SORACLE_HOME/database directory. If the Oracle instance is SAP, copy the
NetBackup example .ut1l fileto initSAP.ut1 as follows:

cp install path/netbackup/ext/db ext/sap/scripts/initSAP.utl \
/oracle/SAP/dbe/initSAP.utl

If a parameter file already exists, make sure the original copy is saved.

2. Set the parameter to the desired value.
Modify initSAP.utl with atext editor. Set parameter policy, schedule, client, server,
and drives to valid values. The following steps set the policy parameter.

a. Use atext editor to open the initSAP.utl file.

b. Find the following line.
policy std

c. Copy and paste this line under the original
policy std

policy std

d. Comment out the original line.

#policy std

policy std

e. Change stdto SAP Backup.

#policy std
policy SAP_ Backup

Repeat Step 2 for each parameter you would like to change. For example, the
following are parameters that will need to be adjusted for your configuration:

policy SAP_ backup
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schedule Default-Application-Backup

client puffin

server puffin

drives

switch list /$SORACLE HOME/sapbackup/.switch.lis
switch sem /SORACLE HOME/sapbackup/.switch.sem
switch log /SORACLE_ HOME/sapbackup/.switch.log

Note Oracle substitution character (? or @) and environmental variable
($ORACLE_HOME) are not allowed in the par_file file.
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Configuring the initSID.sap File

Configure the SAP software by notifying the SAP Tools that you are using the NetBackup
for SAP on UNIX backint interface. This is done by modifying a few parameters in the
SAP profile file. The backup_dev_type parameter needs to be set equal to util_file and the
util_par_file parameter needs to point to the init (SID) .ut1 file.

1.

Locate the Profile file.

The profile file needs to be configured to tell the SAP Tools to use the NetBackup for
SAP on UNIX backint interface. In SORACLE HOME/database, find the existing
initSID. sap configuration file. For example, if the instance is SAP, you will find
initSAP. sap. If one does not exist, copy the sample file from NetBackup as follows:

cp install path/netbackup/ext/db ext/sap/scripts/initSAP.sap \

/oracle/SAP/dbs/initSAP.sap

Save the Original Profile

Since the profile file needs to be modified, it is important to save a copy of the
original. If problems are encountered, restore the old configuration file. One way to
save it is to copy the existing init SID. sap configuration fileto initSAP.sap.org
as follows:

cd $ORACLE_HOME

cd dbs

ls initSAP.sap

cp initSAP.sap initSAP.sap.org

Set parameter backup_dev_type.
a. Use atext editor to open the initSAP. sap file.

b. Find the following line.

backup dev type = tape

c. Copy and paste this line under the original.

backup dev_ type tape
backup dev type = tape

d. Comment out the original line.

#backup dev _type = tape
backup dev type = tape

e. Change tape to util_file.
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#backup dev type = tape
backup dev _type = util file
Set parameter util_par_file.

The next step is to continue to modify text file initSAP. sap with a text editor and
set the parameter util_par_file equal to the backint parameter file. The backint
parameter file is the same file modified in the “Configure the initSID.utl File” on
page 32. This can be done by the following:

a. Find the following

#util par file = <file path>

b. Copy and paste this line under the original.

#util par file = <file path>

#util par file = <file path>

c. Uncomment the original line.

#util par file = <file path>

util par file = <file path>

d. Optional: Change the util_par_file to the absolute path of the parameter file.

#util par file = <file path>
util par file =?/database/inite@.utl

Here is what these changes look like:

backup dev _type = util file
util par file = ?/database/inite.utl

Note When the profile file is interpreted by the SAP Tools, the ? and @ characters will be

substituted with the value assigned to the environmental variables
$ORACLE_HOME and $ORACLE_SID respectively.
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Testing NetBackup for SAP on UNIX Configuration Settings

After configuring the master server for NetBackup for SAP on UNIX, test the
configuration settings. For a description of status codes, refer to the NetBackup
Troubleshooting Guide for UNIX and Windows.

NetBackup Administration Console for Windows

Use this procedure to test a policy configuration from a Windows server or from the
Remote Administration Console.

V¥ To test the configuration settings on a Windows server

1.

2.

Log onto the server as administrator.

Start the NetBackup Administration Console.

In the left pane, click Policies. The policy list appears in the right pane.
Click on the policy you wish to test.

Choose Actions > Manual Backup.

The Manual Backup dialog is displayed.

Manual Backup =
Start backup of policy: =gl2
Schedules: Llients:
schedule_name client_name

Select a schedule and one or maore clients to start the backup.

To start a backup for all clients, press OK without selecting any clients.

Cancel |

The Schedules pane contains the name of a schedule (or schedules) configured for the
policy you are going to test. The Clients pane contains the name of the client(s) listed
in the policy you are going to test.

Follow the instructions on the dialog.
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7. Click Activity Monitor on the NetBackup Administration Console.

] Activity Monitor - dillweed - NetBackup Administration Console o =] )
File Edit View Actions Help |E
B-ml&E % =*|smaalvey B ¥ S |
B O A ENGHLO P PP XD O

dillweed JE =)

& dilweed (Master Server)
3, Activity Monitor

=] g MNetBackup Management
Reports

{3, Policies

{=5] Storage Units

Catalog

Host Properties

=155} Media and Device Manager

H 230 Device Monitar

B Media

Devices

{0 Access Management

< |

I—

dillweed

dillweed: 4 Jobs (0 Queued O Active O Requeued 0 Suspended 0 Incomplete 4 Done) O]
aob 10 [ Type [ aob... [ Status [ Policy [Sch... [ Cient [me... [ star..[stor.. [End.. [ac... |
test auto  dilwesc dilw... 9/15{... s 215/, z
| »
Processes Drives |

For Help, press F1

[Master Server: diweed [Connected 2

If the manual backup does not exit with a successful status, refer to the

Troubleshooting chapter.

NetBackup Administration Console for UNIX

Use this procedure to test a policy configuration on the NetBackup Administration
Console for UNIX.

To test the configuration settings on a UNIX server

1.

2.

Log onto the server as root.

Start the NetBackup Administration Console.

In the left pane, click Policies.

The right pane splits into an All Policies pane and a details pane.

In the All Policies pane, click the policy you wish to test.

Choose Actions > Manual Backup.
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The Manual Backup dialog is displayed.

]
5 Server: hagar
Palicy name: OK
fost
Cancel

Schedules:
schedule_name

Clients:

client_name

Select a schedule and one or more clients to start the hackup. To
start a backup for all clients, press OK without selecting any
clients. Use the Activity Monitor to view progress.

The Schedules pane contains the name of a schedule (or schedules) configured for the
policy you are going to test. The Clients pane contains the name of the client(s) listed
in the policy you are going to test.

6. Follow the instructions on the dialog.

7. Click Activity Monitor on the NetBackup Administration Console.

ﬂnctivity Monitor - hagar - NetBackup Administration Console [logged into hagar] - |EI|1|

VERITAS NetBackup™

File Edit View Actions Help

BlesnHdRSY XO LR TeHE =
hagar {Master Server) : hagar: 79 Total {0 Queued 0 Active 0 Req 1 0 Susg led 0 Inc | 79 Done)
5] hagar (Master Servar) A _gobig | Type | State | Staus | Policy | Schedule | Client [
i;icvﬁ;pnldi:ithonr@l and Restore * 65 Backup Done o test schedule_r client_narme:
@ MetBackup Management
@ 5] Reports
™ Policies
@ (=] Starage Units
GCatalog

@ %8 Host Properties

@ @ Media and Device Management
=) Device Monitar

& B Media

@ |5 Devices

@Access Management
G*@Vaultndanagement

H2 Filesystem Analyzer

[¥]

1
L Jobs [ D [ Processe
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If the manual backup does not exit with a successful status, refer to the
Troubleshooting chapter.

Testing Multiple Drives and Files

To test multiple drives, you must have:

¢ more than one tablespace to back up

¢ multiple tape drives to write to at the same time

You can also use the MPX value to simulate multiple tape drives.

1. Complete the configuration of NetBackup, NetBackup for SAP on UNIX, and SAP
Tools as described previously in this chapter.

2. Change the number of drives in $OrRACLE HOME/dbs/initSAP.utl to equal the
number of tape drives (MPX value X number of tape drives = drives). Refer to
“drives” on page 92 for examples.

drives 2

When you perform a backup, you should see two or more backups running, depending
upon how many drives you have identified in the soraCLE HOME/dbs/initSAP.utl
parameter file. The number of drives in the utility file should match the number of drives
multiplied by the MPX value. The NetBackup for SAP on UNIX backint interface will
wait for all backups to complete before reporting success or failure to brbackup.

> 62 NetBackup for SAP System Administrator’s Guide for UNIX



Using NetBackup for SAP on UNIX 4

When all installation and configuration is complete, you can start SAP backups and
restores through NetBackup.

This chapter contains the following sections:
¢ Performing a Backup
¢ Performing an Archive

¢ Performing a Restore

Caution Always specify the correct SAP script when configuring automatic backups or
when starting operations through NetBackup (see “Creating Scripts” on
page 49). NetBackup for SAP on UNIX will not generate an error if a restore
SAP script file is used for a backup operation or a backup SAP script is used for
a restore operation.
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Performing a Backup

This section contains the following information.
¢ Backup of an SAP Policy

¢ Using xbp

¢ Using SAP to Perform a Backup

Backup of an SAP Policy

Automatic Backup

The most convenient way to back up your database is to set up schedules for automatic
backups. When the NetBackup scheduler invokes a schedule for an automatic backup, the
SAP scripts run:

¢ Inthe same order as they appear in the file list
¢ On all clients that have them (that is, matching path names)
The SAP scripts will start the database backup.

The instructions in the previous chapter, Configuration, explain how to create and
configure a policy that will use the SAP scripts you create to automatically back up your
database according to the schedules you specify. To add a new schedule or change an
existing schedule for automatic backups, follow the guidelines in “Adding New
Schedules” on page 28.

Manual Backup

The administrator can use the NetBackup server software to manually execute an
automatic backup schedule for the SAP policy. Refer to “Testing NetBackup for SAP on
UNIX Configuration Settings” on page 59 for instructions on initiating a manual backup
of an Oracle policy.
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Using xbp to Perform a Backup

Note xbp is not supported on AlX platforms.

The following describes how to use xbp to back up your database. Refer to the xbp man
page and the online help in the interface for detailed instructions on using xbp to back up
the database.

V¥ To perform a backup using xbp

1.

Log in as the SAP administrator or as root.

If you are already logged in under a different user account, use the su - command to
change to the SAP administrator.

Execute xbp on the client to which you want to backup a database.

install path/netbackup/bin/xbp

In the Directory to Search Box, type the path name of the location of the SAP scripts.
For example:

install path/netbackup/ext/db ext/sap/scripts/
Choose File > Browse File System for Backup Scripts.
Select the backup script from the Files pane.

Choose Backup > Backup Database Using Selected Scripts. The xbp_confirm dialog
displays.

Click OK.
A NetBackup process called bphdb starts the SAP script on the client.

View the status of the script execution.

a. Choose Backup > Report Progress Of Backup....
The xbp_progress dialog displays.

b. Select the log file for your backup.
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The Contents of Selected Log File pane displays only the status of the script
execution. A status =0 message indicates that the script was successfully
completed. Go to Step 9 for a detailed status report. For a status other than 0, refer
to the Troubleshooting section of this manual. For additional information, check
the output of the script.

9. View the log file for the NetBackup operation.

a. Change directories to the bphdb log directory.
cd install path/netbackup/logs/bphdb

b. Open the log file with the tail option.
tail -f log.mmddyy

A Backup completed SUCCESSFULLY message indicates a successfully completed
NetBackup operation.

Using SAP to Perform a Backup

There are two ways to start a backup:
¢ sapdba utility menu
¢ Dbrbackup command line

When the backup is started through the sapdba utility or the brbackup command,
brbackup status messages will appear on the console. These messages report when the
database server is started, or stopped. They also report when the backup mode of the
tables is changed. The NetBackup for SAP on UNIX backint interface is then started by
the brbackup command. brbackup submits the files to be backed up.

The NetBackup for SAP on UNIX backint interface will generate messages for each
bpbackup program, and will show a progress log for each. Debugging messages and
bpbackup log messages will also be displayed. During the file-online mode, each
database file is backed up, one at a time. The NetBackup for SAP on UNIX backint
interface handles coordination with brbackup using a semaphore file.

Once all files are backed up, the full file list is displayed in the format required by the
NetBackup for SAP on UNIX backint interface specification as to success or failure. This
format includes a Backup ID (BID) to be used for later restores. SAP Tools will maintain its
own log of the backup session. The standard NetBackup logs will keep track of the images
created. The NetBackup for SAP on UNIX backint interface only needs to keep track of
the BID date and time. This allows cross-referencing by brrestore.
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sapdba Off-line Backup

1. Complete the configuration of NetBackup, NetBackup for SAP on UNIX, and SAP
Tools as described in “Configuration Using the NetBackup Administration Console
for Windows” on page 22 or “Configuration Using the NetBackup Administration
Console for UNIX” on page 35.

2. As user sapadm, stop SAP by executing the stopsap R3 command.

3. Start sapdba.

SAPDBA V4.0B - SAP Database Administration

ORACLE version: 8.0.5.0.0

ORACLE_SID : SAP
ORACLE_HOME : /oracle/SAP
DATABASE : shut down
SAPR3 : not connected
a - Startup/Shutdown instance h - Backup database
b - Instance information i - Backup offline redo logs
c - Tablespace administration j - Restore/Recovery
d - Reorganization k - DB check/verification
e - Export/import 1 - Show/Cleanup
f - Archive mode m - User and Security
g - Additional functions n - SAP Online Help
g - Quit
Please select ==> h
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4. Select the Backup database menu item by typing in h.

Backup database

Current value

a - Backup function Normal backup
b - Parameter file initSAP.sap

c - Backup device type util file

d - Objects for backup all

e - Backup type offline force
g - Query only no

h - Special options

i - Standard backup yes

j - Backup from disk backup

k - Restart backup

1 - Make part. backups compl.

S - Start BRBACKUP

q - Return

Please select ==>d
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5. Select an Object for backup by selecting g and typing PSAPUSERLD.

You will see the backup type is util_file, the backup type is offline_force, and
tablespace is PSAPUSER1D.

Backup database

Current value

a - Backup function Normal backup
b - Parameter file initSAP.sap

c - Backup device type util file

d - Objects for backup PSAPUSER1D

e - Backup type offline force
g - Query only no

h - Special options ...

i - Standard backup yes

j - Backup from disk backup

k - Restart backup

1 - Make part. backups compl.

S - Start BRBACKUP

q - Return

Please select ==>8

6. Start the backup by typing s.

If everything is correct, you will first see sapdba and its command, brbackup,
perform housekeeping on the Oracle database. brbackup will then start the
NetBackup for SAP on UNIX backint interface. When the backup is complete, the
NetBackup for SAP on UNIX backint interface generates a list of files that tells
sapdba/brbackup that the backup was successful.

brbackup On-line Backup

You can use brbackup instead of sapdba to perform database backups. In this example
we will do an on-line backup. You can change the backup mode by changing the
initSAP. sap parameter file or specifying -t online on the brbackup command.

Here is what these changes look like in initSAP. sap:

backup type = online file
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This backup mode allows sapdba/brbackup to use a semaphore file with the
NetBackup for SAP on UNIX backint interface. This provides better on-line backup
when doing very large files, since only the necessary tablespaces are placed in backup
mode. When NetBackup is ready to process another file, it notifies brbackup. You can
change the backup mode to online to test this mode.

1. Complete the configuration of NetBackup, NetBackup for SAP on UNIX, and SAP
Tools as described in “Configuration” on page 21.

2. Asthe SAP administrator user, call brbackup.

brbackup -d util file online -t online -m all
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Performing an Archive

An archive is executed in a similar fashion as a backup. The brarchive command creates
multiple successful backups before deleting the redo log file. NetBackup for SAP on UNIX
is used for each archive run.

Creating Backup Copies of Archive Logs

It is possible to create two backup copies of an archive log. You can store each copy on
separate media, and retrieve them fairly easily. The policy log, sched log, and
second_secondary_archive parameters were created to help facilitate this task.

In addition, there are two alternative methods to accomplish this task. We present all three
methods here, along with the advantages and disadvantages of each methods. Depending
on how you use NetBackup for SAP, choose the method of creating archive log backup
copies that is easiest for you.

Solution 1: Using policy_log, sched_log, and
second_secondary_archive Parameters

NetBackup For SAP has an ability to create a second backup copy of an archive log. This
feature is regulated through optional parameters, policy logand schedule log,
both located in init<SID>.utl file.

This feature, however, is not integrated with SAP Tools. SAP Tools are not "aware" of the
second backup copy. Should first backup copy become unavailable, the user would have
to know NetBackup (NB) backup id (BID) of the second backup copy in order to restore it.

Example
The user performs a backup of the archive log:
brarchive -d util file -s

This will automatically find an archive log that is ready to be backed up, for example,
archive log 77.Assumingthat policy logand schedule log parameters were
properly set, NetBackup for SAP will create two backup copies. These backup copies can
be stored to disk or tape, two different tapes, or any desired backup media combination.

To restore archive log 77, issue the following command:
brrestore -d util file -a 77

This will automatically determine the NB backup ID (BID) needed to restore the desired
archive log. This backup ID is always for the first backup copy.
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Unfortunately, brrestore is not aware of second copy. If the first backup copy is lost,
brrestore will not be able to automatically find the second backup image that can be
used for restore. The user will have to explicitly provide the alternative backup ID to
brrestore. For example:

brrestore -d util file -b2 NS0123456789 -m /ora/SAP/saparch/SAParchl_77.dbf

Advantages:
¢ Easy administration through init<SID>.utl file.

¢ Any combination of backup media can be used.

Disadvantages:

¢ In practice this presents administrator with an additional task of keeping track of NB
backup IDs that can be used for restore in case first backup image is lost.

Solution 2: Using Two brarchive Commands in Sequence

The user can also create a backup copy of the archive log by issuing two brarchive
commands in sequence. For the first copy, the user must call brarchive with the -s
option. For the second copy, the user calls brarchive with the -sc option.

Example

Assume that there is only one archive log to be backed up, archive log 77.Both
commands will automatically determine that it needs to be backed up and perform the
backup.

To create the first backup copy, issue the following command:
brarchive -d util file -s

To create the second backup copy, issue the following command:
brarchive -d util file -sc

Following these backups, the user can restore the archived log files by issuing the
brrestore command

To restore the first backup copy:
brrestore -a 77
To restore the second backup copy:

brrestore -a2 77
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Advantages:

¢ Both backup copies can be stored different media, two tapes, disk and tape or any
desired combination.

¢ Restore is easy.

Disadvantages:
& Dbrarchive has to be called two times.

¢ User must ensure that the first and second schedules specify different NetBackup
schedules, because that is how NetBackup regulates which storage unit will be used.

Solution 3: Using Inline Tape Copy

Inline Tape Copy is a separately licensed feature of NetBackup. NetBackup for SAP users
that also have the inline tape copy feature can use the feature to automatically create
backup copies of the archive log file.

Example

To create two backup copies using inline tape copy, issue the following command:
brarchive -d util file -s

This will create two backup copies that will be stored on two different tapes.

To restore the first available copy of the archive log file, issue the following command:

brrestore -d util file -a <log number>

Advantages:

¢ Inline tape copy results in a transparent restore. If first copy became unavailable,
second copy will be picked up automatically.

¢ More than two copies can be created during backup.

Disadvantages:
¢ The only backup media currently supported is tape.

¢ Inline tape copy requires an additional license.
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Performing a Restore

Using xbp to Perform a Restore

The following describes how to use xbp to restore your database. Refer to the xbp man
page and the online help in the interface for detailed instructions on using xbp to restore
database backups.

To use xbp to perform a restore

1.

Log in as the SAP administrator or as root.

If a different user account is used, change the su- command to the SAP administrator.

Execute xbp on the client to which you want to restore a database.

install path/netbackup/bin/xbp

In the Directory to Search Box, type in the path name of the location of the SAP scripts.
For example:

install path/netbackup/ext/db ext/sap/scripts/
Choose File > Browse File System for Restore Scripts. The xbp dialog is displayed.
Select the restore script from the Files pane.

Choose Restore > Restore Database Using Selected Scripts. The xbp_confirm dialog
is displayed.

Click OK.

A NetBackup process called bphdb starts the SAP script on the client.

View the status of the script execution.

a. Choose Restore > Report Progress Of Restore....

The xbp_progress dialog is displayed.

b. Select the log file for your restore.

The Contents of Selected Log File pane displays only the status of the script
execution. A status =0 message indicates that the script was successfully
completed. Go to Step 9 for a detailed status report. For a status other than 0, refer
to the Troubleshooting section of this manual.
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9. View the log file for the NetBackup operation.

a. Change directories to the bphdb log directory.
cd /usr/openv/netbackup/logs/bphdb

b. Open the log file with the tail option.
tail -f log.mmddyy

A Restore completed SUCCESSFULLY message indicates a successfully completed
NetBackup operation.

Using sapdba to Perform a Restore

To restore a partial or full database, the sapdba system should be used to maintain the list
of valid restores for specific tablespace or complete database restores. Refer to BC SAP
Database Administration for restore examples.

Before restoring either individual tablespaces or full databases, the user is prompted prior
to deleting an existing copy of the target file. sapdba will then invoke the brrestore
command.

brrestore submits the BID and filename list to the NetBackup for SAP on UNIX
backint interface. The backint interface will cross-reference the exact date and time to
when the backup was made and uses NetBackup to recover the file. The backint
interface monitors the progress of the restore and reports status back to brrestore.

Upon completion, the backint interface saves a copy of the NetBackup restore logs for
auditing purposes. sapdba then provides required database recovery, such as media
recovery, and restarts the database server.
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Redirecting a Restore to a Different Client

v

You have the option to restore an SAP Database to a client other than the one that
originally supplied the backup. This process of restoring data to a different client is called
a redirected restore.

In order to perform a redirected restore, the following conditions must be true:

¢ The source and destination clients must have identical computer system architecture
and OS versions and bit-levels.

& The source and destination clients must have identical Oracle RDBMS levels.

Note In some situations it is possible to restore from lower to higher release levels of
Oracle. Refer to the Oracle documentation or support for details.

The redirected restore is a 4 part process:

1. Configuring the NetBackup server

2. Copying files from the source client to the destination client
3. Configuring the NetBackup for SAP destination client

4. Performing the redirected restore

The following procedure explains each part of the process in detail. For more information

on redirected restore, see the NetBackup System Administrator’s Guide.

To perform a NetBackup for SAP redirected restore

1. Configure the NetBackup server to allow redirected restores. You must be the
NetBackup administrator to perform these tasks.

To remove restrictions for all clients, create the following file on the Netbackup master
sever:

install path/netbackup/db/altnames/No.Restrictions

Or, to restrict clients to restore only from certain other clients, create the following file:
install path/netbackup/db/altnames/client name

(where client_name is the name of the client allowed to perform the redirected restore).
Add the name of the NetBackup for SAP source client to that file.

2. Copy configuration and control files from the NetBackup for SAP source client to the
NetBackup for SAP destination client.
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Note Before overwriting the files on the destination client, back up the control files to
preserve the original configuration. These files are usually in the
$ORACLE HOME/database directory.

The file copy can be accomplished by using ftp — File Transfer Protocol.

a. Copy the following files from the source client (normally in
$ORACLE_HOME/database) to the same directory on the destination client:
¢ init<SID>.sap
& init<SID>.utl

b. Copy the following control files from $ORACLE_HOME/sapbackup on the source
client to the same directory on the destination client.
¢ back<SID>.log
¢ SAP backup log file

(This is an 8 letter file with extension that depends on the type of backup
performed, for example, bdhautdo. af £ for a full offline backup.)

3. Configure the NetBackup for SAP destination client as follows:

a. Change the client paramter in the init<SID>.utl file on the destination client to the
name of the source client.

b. Alternately, set the SAP_CLIENT environment variable on the destination client
to the name of the source client:

SAP_CLIENT=<source client>
export SAP_ CLIENT

Note The SAP_CLIENT variable has higher priority than the value in the init<SID>.utl
file

c. Setthe restore_filter paramter in the init<SID>.utl file on the destination client.

If the source client path is set to /home db/oracle/sap and the input file
contains the path /oracle/SAP, then the value of restore_filter would be a script
such as the following:

#!\/bin\/sh

# this shell is used to change some logically linked files
# during a restore

sed -e !

s\/oracle\/SAP\/home db\/oracle\/sap\/' $1 > $2
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d. Create a symbolic link on the destination client that resembles the actual path of
the source client and point it to the directory that points to the SAP files.

Note Do not use the -m<dest_dirs> option with brrestore to achieve the same effect.
This will result in the files being restored to the directory you specify, rather than in
the original directories.

4. Perform the redirected restore.
a. Log onto the NetBackup for SAP destination client.

b. Perform the

brrestore -d util file -b last -m full

Redirected Restore Sample Environment

This sample environment shows how a redirected restore uses the restore_filter script.
This example assumes the following:

¢ Source client
¢ Actual path is /home_db/oracle/sap

¢ Also has soft link: /oracle/SAP (SAP is the sytem ID), which points to
/home_db/oracle/sap.

¢ Destination client
¢ Actual path is /home2/sap
¢ Also has soft link: /oracle/SAP which points to /home2/sap.
¢ Make soft link /home db/oracle/sap, which points to /home2/sap

In the restore_filter script, we substitute the path provided in the input file list of the
destination client into the actual path of the source client. The resulting script sample
might look like the following:

#!/bin/sh

# this shell is used to change some logically linked files
# during a restore

sed -e !

s\/oracle\/SAP\/home db\/oracle\/sap\/' $1 > $2

When the backup starts, the file list contains the file path with a soft link:
/oracle/SAP/sapdatal/btabd 1/btabd.datal
But the file is really backed up with the actual path;
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/home_db/oracle/sap/sapdatal/btab d/btabd.data

When the request for a restore is issued, the input file list contains file paths with soft
links. These are converted to the actual path of the destination client. Since this path is
different from the source client path, the restore would fail in the inquire phase. To
prevent this, use the restore filter script.
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Troubleshooting 5

This chapter provides processes and resources to help you troubleshoot NetBackup for
SAP on UNIX, including logs and reports that NetBackup, NetBackup for SAP on UNIX,
and the SAP Tools provide. These reports are useful for finding errors associated with
those applications.

This chapter includes the following sections:
¢ Setting the Debug Level

¢ NetBackup Reports

¢ sapdba Logs and Messages

¢ Preventing Timeout Failures on Large Database Restores




Setting the Debug Level

Setting the Debug Level

You can control the amount of information written to the debug log in the
install_path/netbackup/logs/ by changing the Database debug level. The higher the
value, the more information is logged. In everyday normal operations, the default value of
0 is sufficient. However, VERITAS Technical Support may ask you to set the value higher
when a problem is being analyzed. 5 is the highest possible setting.

NetBackup Reports

The NetBackup server and client software allow you to set up detailed debug logs for
troubleshooting problems that occur outside of either NetBackup for SAP on UNIX or the
SAP Tools. In addition to the NetBackup for SAP-specific directories explained in the
following section, you should also create directories for general NetBackup client debug
logs, such as bpbackup, bprestore, bpbkar, and tar. See the NetBackup Troubleshooting
Guide for UNIX and Windows for a complete description of debug logs. Also see the
install_path/usr/openv/netbackup/logs/README. debug file.

Note These logs do not reveal errors that occur during the execution of the SAP Tools,
unless those errors also affect NetBackup for SAP. SAP may (or may not) use the
NetBackup for SAP logs for errors in the application. Your best sources for SAP
error information are the logs provided by SAP.

Note In general, each debug log corresponds to a NetBackup process and executable.

To enable the NetBackup for SAP on UNIX logs

1. Create the following directories on the client:

install path/netbackup/logs/bphdb
install path/netbackup/logs/backint

% cd install path/netbackup/logs/
% mkdir bphdb

)

% mkdir backint

The following sections describe the logs created when you create the log directories. Use a
text editor to view the contents of the logs.

v
-——
— .7
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bphdb on the Client

The install_path /netbackup/logs/bphdb directory contains the following types of logs.
These logs are a good starting place to determine what type of error occurred.

sap_stdout.mmddyy

Unless redirected elsewhere, NetBackup places SAP script output in this file.
sap_stderr.mmddyy

Unless redirected elsewhere, NetBackup places SAP script errors in this file.
mmddyy

bphdb is the NetBackup Database Backup binary. This log contains
debugging information for the bphdb process. NetBackup for SAP on UNIX
uses this client process for SAP script execution. It is invoked when an
automatic backup schedule is executed.

backint on the Client

The install path/netbackup/logs/backint directory contains the following
execution log.

mmddyy

This log contains debugging information and execution status for the SAP
NetBackup client processes linked to the library program provided with
NetBackup for SAP on UNIX.

install path/netbackup/logs/

NetBackup Server Reports

NetBackup provides other reports that are useful in isolating problems. One such report is
All Logs Entries on the server. See the NetBackup System Administrator’s Guide for Windows,
Volume | or NetBackup System Administrator’s Guide for UNIX, Volume | for a description of
this and other reports.

sapdba Logs and Messages

The SAP Tools log provides information on the SAP part of the operation. This is the log
the database administrator must check to determine the ultimate success or failure of the
database backups and restores.
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The sapdba utility log can view backup and restore logs. You can find them in the
sapdba menu option: Show/Cleanup; Show log files/profiles. The same log information
can be found in a few directories for brbackup/brrestore log information and
brarchive log information.

Backup and Restore Folder

SORACLE HOME/sapbackup

This directory contains files that represent different types of backups and restores.

backSID.log - summary log
encode timestamp.xyz - detail logs

where

SID = a unique name for an Oracle database instance. Also known as System ID.

encoded timestamp = a timestamp used in each detail log name which guarantees

unique filenames

x =a (all), p (partial)
y = n (online), f (offline)

z = f (utility_file_backup)

xyz = rsb (restore backup files)

Xyz = rsa (restore archive files)

xyz = rsf (restore individual files)

Archive Folder

$ORACLE_HOMEsaparch

This directory contains files that represent different types of archives.

encode timestamp . sve
encode timestamp . svd
encode timestamp . cpy
encode timestamp . cpd

encode timestamp . dcp

original saved

original saved and deleted

original copied/saved a second time

original copied/saved a second time and deleted

deleted which were saved twice
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encode timestamp . dsv deleted which were saved

Preventing Timeout Failures on Large Database Restores

Large database restores sometimes fail when multiple restore sessions compete for
resources. In this situation, a restore session can be delayed waiting for media or device
access. If the delay is too long, the restore session times out.

This problem can be resolved by increasing the Client Read Timeout property, which
prevents session timeouts and allows the restores to complete successfully.

Use the NetBackup Administration Console on the server to change the properties of each
client that contains a database you may need to restore. The Client Read Timeout
property is found on the Timeouts host properties dialog of the master and media servers.
The default for the Client Read Timeout setting is 300 seconds (5 minutes). For database
agent clients, increase the value significantly to prevent timeout errors, e.g. 30 minutes.
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The backint command line uses the following syntax.

backint -u user id -f function [-t type]l -p par_file [-i in_file] [-o out_file]

-u user id

-f function

backup

restore

inquiry

-t type

file

UID for backup utility user. No default. Required option.

This is arequired parameter for the backint interface. It defines a key
value that performs different functions between SAP and NetBackup.
One of the following options is required.

This is an optional parameter value for the - £ function parameter. It
supports and defines brbackup and brarchive to NetBackup. If
backup is specified, NetBackup will perform a backup for SAP.

This is an optional parameter value for the - £ function parameter. It
supports and defines brrestore to NetBackup. If restore is specified,
then NetBackup will perform a restore for SAP.

This is an optional parameter value for the - £ function parameter. It
supports and defines sapdba to NetBackup. This option is used by
sapdba when a recovery is performed to get backup information for
NetBackup.

This is an optional parameter for the backint command. It defines
backup type, backup of individual files, and character special devices.
If it is not specified the default value is file.

This is the default parameter value for the -t type parameter. It
defines when to perform a backup, restore and inquiry function with
datafiles, and special character devices. Backups from directories are
not supported.




file online Thisisan optional parameter value for the -t type parameter. It

-p par_file

-i in_file

allows brbackup to set tablespace into #BEGIN/#END backup mode
when a related file backup takes place. It is used for on-line backups
only. The architecture is based on three control files defined in the -p
par_file parameter.

This is a required parameter for the backint command. It is a text file
that contains comments, parameters (required and optional), and
parameter values. These parameters determine the backup and restore
procedure between NetBackup and SAP Tools.

Comments are denoted by # in the first column. Any other character in
the first column is considered a valid parameter.

A required parameter must be specified with a valid value before the
NetBackup for SAP on UNIX backint interface will execute correctly.
An optional parameter can be commented out by a # in the first
column. If the optional parameters are specified, they must have valid
values for the NetBackup for SAP on UNIX backint interface to
execute correctly. If an invalid parameter name is found, the
NetBackup for SAP on UNIX backint interface will report a warning
message and will continue executing. For details on input file contents,
refer to the following -i in_file parameter.

The SAP Tools parameter file (profile file; initSID.sap) specifies
the location of this par_file. An example of this file is located in:

install path/netbackup/ext/db ext/sap/scripts/initSAP.
utl

For details on input file contents, refer to “backint -p par_file or
initSID.utl” on page 99 of this manual.

This is an optional parameter for the backint command. It is a text
file, the contents of which may vary, depending on the NetBackup for
SAP on UNIX backint interface function initiated. If this parameter
is not specified, the contents of this file is data from standard input.
For details on input file contents, refer to “backint -i in_file
Contents” on page 91 of this manual.
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-o out_file This is an optional parameter for the backint command. It is a text
file that contains process messages for a function. If it is not specified,
the output will go to standard output. For details on output file
contents, refer to “backint -oout file Contents” on page 93 of

this manual.
———
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The contents of the input text file will change depending on the function initiated by the
NetBackup for SAP on UNIX backint interface.

Backup Function

For the backup function, you may have the following entries.

filel Set of file names to be saved.
special_filel sizel Character special (raw) device files and the file size used by
Oracle.

Restore Function

For the restore function, you may have the following entries.

backup_id filel BIDs of backups. Names of files and/or directories to be restored.
[dest_dirl] Optional destination directory.
[#NULL file2 Optional. Additional names of files and or directories with a
[dest_dir2]] different destination directory.
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Restore Function

Inquiry Function

For the inquiry function, you may have the following entries.

#NULL Lists the last backup.
[backup_id] Optional BIDs will list all backups.
[#NULL file1] Optional null with names of files and or directories will list all

backups with the specified file/directory names.

[backup_id file2] Optional BIDs and directories of files and or directories will list
the specified files or directory names in the specified backups.
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The contents of the output text file will change depending on the function initiated by the
NetBackup for SAP on UNIX backint interface.

Backup Function
When a backup function is successfully completed, the output file entry will identify the
BID assigned to the backup by NetBackup and will list the files and directories backed up.
#SAVED backup_id file

When a backup function fails, the output file entry will list the files that were not
successfully backed up.

#ERROR file

Restore Function

When a restore function is successfully completed, the output file entry will identify the
BID and list the files restored.

#RESTORED backup_id file

When a restore function fails, the output file will list the files and directories not found. It
will also list the files and directories that were not successfully restored.

#NOTFOUND file
#ERROR file




Inquiry Function

Inquiry Function
When an inquiry function is successfully completed, the output file entry will identify the
BID assigned to the backup by NetBackup and/or will list the files backed up.

#BACKUP backup_id
#BACKUP backup_id file

When an inquiry function fails, the output file lists the files that where not successfully
backed up.

#ERROR file
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Environment Variables

The NetBackup for SAP on UNIX backint interface will recognize the following
environmental variables.

$SAP_SERVER

$SAP_CLIENT

$SAP_POLICY

$SAP_SCHED

$SAP_DRIVES

This environmental variable sets the name of the NetBackup server. It
can be used to override the current server and perform a backup to an
alternative server. This environmental variable is the same as the
server parameter in the par_file (initSI1D.ut1l) file and the SERVER
option in the NetBackup bp . conf file.

This environmental variable sets the name of the NetBackup client. It
can be used to override the current client and perform an alternate
restore to a different client. This variable is the same as the client
parameter in the par_file (initSID.utl) file and the CLIENT_NAME
option in the NetBackup bp . conf file.

This environmental variable sets the name of the NetBackup policy.
This policy can be used to define different types of database backups.
One policy type can be used to perform offline database backups, and
another policy type can be used to perform archive log backups. This
environmental variable is the same as the policy parameter in the
par_file (initSID.ut1l) file and the BPBACKUP_POLICY option in
the NetBackup bp . conf file.

This environmental variable sets the name of the SAP Backup Policy
schedule. This schedule provides an easy way to switch to a different
schedule for each SAP database backup. This environmental variable is
the same as the schedule parameter in the par_file (initSID.utl)
file and the BPBACKUP_SCHED option in the NetBackup bp . conf
file.

This environmental variable sets the number of simultaneous
bpbackup/bprestore operations the NetBackup for SAP on UNIX
backint interface will execute. This environmental variable is the
same as the drives parameter in the par_file (initSID.utl) file.
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E

There are a number of parameters that can be specified in either the

install path/netbackup/bp.conf file or the SHOME /bp. conf file. These
parameters will be used by the NetBackup for SAP on UNIX backint interface if they are
not found as an environmental variable or in the par_file (initSID.utl) file. The
server, client, policy and schedule parameters in the par_file (initSID.ut1l)can
all be defined in the bp . conf file. The following is a list of the variable names and

definitions.

SERVER

CLIENT_NAME

BPBACKUP_POLICY

BPBACKUP_SCHED

This is the option, in the bp . conf file, which names the
NetBackup server. This option is the same as the $SAP_SERVER
environment variable and the server parameter in the -p par_file
file.

This is the option, in the bp . conf file, which names the
NetBackup client. This option is the same as the $SAP_CLIENT
environment variable and the c1lient parameter in the -p par_file
file.

This is the option, in the bp.conf file, which names the
NetBackup policy. This option is the same as the $SAP_POLICY
environment variable and the policy parameter in the -p par_file
file.

This is the option, in the bp.conf file, which names the
NetBackup schedule. This option is the same as the $SAP_SCHED
environment variable and the schedule parameter in the -p
par_file file.

See the NetBackup System Adminstrator’s Guide Volume Il for UNIX or the NetBackup System
Administrator’s Guide Volume Il for Windows for additional information on bp . conf.
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server

client

This is an optional parameter, used to define the machine name of the NetBackup master
server. The NetBackup master server is the name of the machine that provides most of the
administration and control for NetBackup operations. It contains the NetBackup database.
The following is an example entry:

server jupiter

If the NetBackup for SAP on UNIX backint interface finds a $SAP_SERVER
environment variable, the server parameter value will be overridden by the
$SAP_SERVER value. If the server parameter is not specified, and there is no
environment variable, then the server parameter value will default to the SERVER
option specified in NetBackup /usr/openv/netbackup/bp.conf.

This is an optional parameter, used to set a machine name that contains the NetBackup
client software, an Oracle database, and an SAP environment. In some cases the server
and client machine will be the same machine. The following is an example entry:

client saturn

If the NetBackup for SAP on UNIX backint interface finds a $SAP_CLIENT
environment variable, the client parameter value will be overridden by the
$SAP_CLIENT value. If the client parameter is not specified, and there is no
environment variable, then the c1ient parameter value will default to the
CLIENT_NAME option specified in the NetBackup bp . conf file. If the value is not
specified in the NetBackup bp . conf file, the NetBackup for SAP on UNIX backint
interface uses the value returned by the gethostname () library function.




drives

drives

policy

This is an optional parameter, used to determine the number of bpbackup/bprestore
commands that will be run. To maximize write performance to a tape, the drives value
should be set to the number of tape drives multiplied by the MPX value per schedule.
Based on the number of drives specified, the NetBackup for SAP on UNIX backint
interface will simultaneously run the same number of bpbackup/bprestore
commands.

If, for example, MPX is set to 4 and there are two available tape drives, then the drives
parameter should be set to 8 (4 X 2). The NetBackup for SAP on UNIX backint interface
will run eight bpbackup/bprestore jobs at the same time. As a result there will be four
data streams going to each tape. The drives parameter should be set to the following
rule:

drives = Number of drives per policy x MPX value in schedule

The drives parameter value should not exceed the Set Maximum Jobs per Client global
attribute. The following is an example entry:

drives 5

If the NetBackup for SAP on UNIX backint interface finds a $SAP_DRIVES
environment variable, the drives parameter value will be overridden by the
$SAP_DRIVES value. If the drive parameter is not specified and there is no environment
variable, then the NetBackup for SAP on UNIX backint interface will exit with an error.

This is an optional parameter, used to set the name of an SAP policy type defined in
NetBackup. The SAP policy must have a Backup Policy schedule defined in order for the
NetBackup for SAP on UNIX backint interface to work. The following is an example
entry:

policy sap nb

If the NetBackup for SAP on UNIX backint interface finds a $SAP_POLICY
environment variable, the policy parameter value will be overridden by the
$SAP_POLICY value. If the policy parameter is not specified, and there is no environment
variable, then the policy parameter value will default to the BPBACKUP_POLICY
option in the NetBackup bp . conf file. By default, if BPBACKUP_POLICY is not in any
NetBackup bp . conf file, NetBackup uses the first active SAP policy type it finds for the
client with a Backup Policy backup schedule.
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policy2

This is an optional parameter, used to set the name of an policy to be used for the
secondary SAP backup. The secondary backup is performed for each SAP database
backup on files that are needed to track SAP backup information. This option would be
used to save the backup information on a different media. If policy2 is not specified and
schedule2 is specified, then the policy parameter value is used.

backint_dir

This is an optional parameter that should only be set if you have old backups performed
with NetBackup 3.2. It must be set to a public directory. The NetBackup for SAP on UNIX
backint interface uses this directory for work space. NetBackup for SAP will look for
backint.times file, and search it for previously performed backups (using NetBackup for
SAP 3.2). Note that NetBackup for SAP 4.5 will not use backint.times file to store
information about new backups.

schedule

This is an optional parameter, used to set the name of a Backup Policy schedule associated
with an SAP policy type. The schedule can define aspects of the backup such as how long
NetBackup retains images, maximum MPX per drive, storage unit, and volume pool. The
following is an example entry:

schedule sap full backup

If the NetBackup for SAP on UNIX backint interface finds a $SAP_SCHED environment
variable, the schedule parameter value will be overridden by the $SAP_SCHED value. If
the schedule parameter is not specified and there is no environment variable, then the
schedule parameter value will default to the BPBACKUP_SCHED option in the
NetBackup bp.conf file. By default, if BPBACKUP_SCHED is not in any NetBackup

bp . conf file then, NetBackup uses the first Backup Policy schedule it finds in the first
active SAP policy.

schedule2

This is an optional parameter, used to set the name of an Application Backup schedule to
be used for the secondary SAP backup. If it is not specified, then the schedule parameter
value is used.
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sleep

For each SAP backup, there are two individual backups performed. The first backup is
responsible for backing up database data. The second backup is responsible for backing
up log files needed to track SAP backup information. Use this parameter to save SAP log
files to a different media. This can make database restore/recovery easier. This option can
be used to save the backup information to a different volume pool. The following is an
example entry:

schedule2 sap backup_information

This is an optional parameter, used to specify a sleep time to monitor the bpbackup or
bprestore logs. If it is not specified, the value is set to a default of five seconds.

When the NetBackup for SAP on UNIX backint interface is called, a number of
bpbackup/bprestore commands can be running at the same time. The NetBackup for
SAP on UNIX backint interface monitors each command and writes to the file that is
specified on the -o out_file parameter. In some cases, bpbackup/bprestore information is
not displayed because of the monitoring cycle. Therefore, this option is used mainly for
debug reasons. The following is an example entry:

sleep 3

media_notify_script

This is an optional parameter, used to call a script when awaiting mount is entered in a
bpbackup/bprestore log. It can be used to display a mount tape message to an SAP
user. The value for this option must be the full path name to a script. The script should
have the right file permissions (chmod 755). Test the script before implementation. The
following is an example of an entry:

media notify script /oracle/sap/sapscripts/sap _media notify

If the message is encountered and this option is specified, then the following commands
will be executed from the NetBackup for SAP on UNIX backint interface:

MEDIA ID=A001;export MEDIA ID
NETBACKUP_SERVER=gaturn;export NETBACKUP SERVER
/oracle/sap/sapscripts/sap _media notify
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restore_filter

This is an optional parameter, used to resolve linked file paths on a restore. This
parameter should be used only on rare occasions. The following cases must exist before
this parameter is used:

¢ Oracle table spaces use file paths
¢ The directory paths to the Oracle table spaces are linked paths
¢ The linked directory paths do not exist at restore time

The value for this parameter must be a fully qualified file path name to a script with the
right permissions. Test the script before implementation. The following is an example of
an entry:

restore filter script /usr/openv/netbackup/ext/db_ext/sap/\
scripts/sap_restore filter

The script must have an input parameter and an output parameter. It must be able to
modify the contents of a text file. The script is responsible for converting linked directory
paths into absolute directory paths. The following is an example of this script:

#!/bin/sh
# this shell is used to change some logically linked files

# during a restore
# /oracle/sap/sapdata/sapdatal to /oracle/product/7.0.16/sapdatal
# /oracle/sap/sapdata/sapdata2 to /oracle/product/7.0.16/sapdata2
# /oracle/sap/sapdata/sapdata3 to /oracle/product/7.0.16/sapdata3
# /oracle/sap/sapdata/sapdata4 to /oracle/product/7.0.16/sapdata4
# /oracle/sap/sapdata/sapdata5 to /oracle/product/7.0.16/sapdata5s
# /oracle/sap/sapdata/sapdataé to /oracle/product/7.0.16/sapdataé6
sed -e '/
s/Voracle\sap\sapdata\/sapdatal/Voracle\/product\/7.0.16\/sapdatal/
s/Voracle\sap\sapdatal/sapdata2/\Voracle\product\/7.0.16\/sapdata2/
s/Voracle\sap\sapdata\/sapdata3/\Voracle\product\/7.0.16\/sapdata3/
s/Voracle\sap\sapdata\/sapdata4/Voracle\product\/7.0.16\/sapdatad/
s/Voracle\sap\sapdatal/sapdata5/\Voracle\/product\/7.0.16\/sapdata5/
s/Voracle\Vsap\sapdata\/sapdata6/\Voracle\product/\7.0.16\/sapdata6\/’
S1 > $2

bplist_filter

This is an optional parameter, used to resolve linked file paths on an inquire. This
parameter should be used only on rare occasions. Asin restore filter script all of
the following cases must exist before this parameter is used:
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¢ Oracle table spaces use file paths
¢ The directory paths to the Oracle table spaces are linked paths
¢ The linked directory paths do not exist at restore time

The value for this option must be a fully qualified path name to a script with the right file
permission. Test the script before implementing. The following is an example of an entry:

bplist filter script /usr/openv/netbackup/ext/db_ext/sap/scripts\
/bplist restore filter

The script must have an input parameter and output parameter and be able to modify the
contents of a text file. The script is responsible for converting absolute directory paths into
linked directory paths. This is just the opposite of restore filter script.The
following is an example of this script:

#!/bin/sh
# this shell is used to change some logically linked files

# during a restore

# /oracle/sap/sapdata/sapdatal to /oracle/product/7.0.16/sapdatal
# /oracle/sap/sapdata/sapdata2 to /oracle/product/7.0.16/sapdata2
# /oracle/sap/sapdata/sapdata3 to /oracle/product/7.0.16/sapdata3
# /oracle/sap/sapdata/sapdata4 to /oracle/product/7.0.16/sapdata4
# /oracle/sap/sapdata/sapdata5 to /oracle/product/7.0.16/sapdata5s
# /oracle/sap/sapdata/sapdataé to /oracle/product/7.0.16/sapdataé
sed -e
s/Voracle\sap\sapdata\/sapdatal/Voracle\/product\/7.0.16\/sapdatal/
s/VoracleVsap\Vsapdatalsapdata2/\Voracle\Vproduct\/7.0.16\/sapdata2/
s/VoracleVsap\Vsapdatalsapdata3/\Voracle\Vproduct\/7.0.16\/sapdata3/
s/VoracleVsap\Vsapdatalsapdata4/\Voracle\Vproduct\/7.0.16\/sapdata4/
s/VoracleVsap\VsapdatalVsapdatas5/\Voracle\Vproduct\/7.0.16\/sapdata5/
s/VoracleVsap\VsapdatalVsapdata6/\Voracle\Vproduct/\7.0.16\/sapdata6\/’

S1 > $2

check_directory flag

This is an optional parameter, used to allow directory backup.

If this parameter issetto 0 (false), and an attempt is made to back up a directory or
subdirectory, the NetBackup for SAP on UNIX backint interface will report an error. When
this parameter issetto 1 (true), SAP Tools will be able to back up directories and
subdirectories. The following example allows directory backup:

check directory flag 1
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switch_list

This is a required parameter. It is used as a control file to communicate with the
NetBackup for SAP on UNIX backint interface and brbackup for on-line backups. A
switch list file is created every time brbackup wants to back up a file, or when it wants to
indicate that a backup is finished. The switch 1ist parameter must be set to a file path
located in:

$ORACLE HOME%/sapbackup/.switch.lis.
The following is an example of a valid entry:

switch list /SORACLE HOME/sapbackup/switch.lis

switch_sem

This is a required parameter. It is used as a control file between the NetBackup for SAP on
UNIX backint interface and brbackup. After the switch list file has been created and
closed, the NetBackup for SAP on UNIX backint interface creates the switch semaphore
file and waits until it is deleted by brbackup. The switch sem parameter must be set to
a file path located in: $ORACLE HOME$%/sapbackup/.switch.sem. The followingisan
example of a valid entry:

switch sem /$SORACLE_HOME/sapbackup/switch.sem

switch_log

This is a required parameter. It is used as a control file between the NetBackup for SAP on
UNIX backint interface and brbackup. After the switch semaphore file has been
deleted, the NetBackup for SAP on UNIX backint interface opens and reads the switch
log file, created by brbackup, to determine if the process is successful. The switch log
parameter must be set to a file path located in:

$ORACLE _HOME%/sapbackup/.switch log. The following is an example of a valid
entry:

switch log /$ORACLE HOME/sapbackup/switch.log

sort_backup_type

This is optional parameter, used to specify one of four different backup sort parameter
values [size | custom | device | drive ]. If it is not specified, it will default to the size
option.

The following is detailed information on each parameter value.
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size

This is the default parameter value for the sort backup type parameter. The size
feature will create bpbackup jobs based upon the number of drives specified in the
par file (drives 3). Each file being backed up will be associated with a backup job
based on size. For example, if three tape drives are specified, the files will be divided
evenly into three bpbackup jobs based on size. So, if there are 25 input files from SAP
and three tape drives, then three bpbackup jobs would be running at the same time
with the following files in each job.

Input file list from SAP (brbackup, sapdba)

/oracle/sap/sapdatal/btabd 1/btabd.datal
/oracle/sap/sapdata2/btabi 1/btabi.datal
/oracle/sap/sapdata2/clud 1/clud.datal
/oracle/sap/sapdatal/ddicd 1/ddicd.datal
/oracle/sap/sapdata5/ddici 1/ddici.datal
/oracle/sap/sapdata4/el30cd_1/EL30cd.datal
/oracle/sap/sapdatal/el30ci_1/el30ci.datal
/oracle/sap/sapdata6/es30cd_1/es30cd.datal
/oracle/sap/sapdata2/poold_1/poold.datal
/oracle/sap/sapdatal/pooli 1/pooli.datal
/oracle/sap/sapdata4/protd_1/protd.datal
/dev/rdsk/c0t4d0s6 11812864
/oracle/sap/sapdatal/roll 1/roll.datal
/oracle/sap/sapdata2/sourced 1/sourced.datal
/oracle/sap/sapdata3/stabd 1/stabd.datal
/oracle/sap/sapdata2/stabi 2/stabi.data2
/oracle/sap/sapdatal/temp 1/temp.datal
/oracle/sap/sapdata4/userld_1l/userld.datal
/oracle/sap/sapdata2/userli 1/userli.datal
/oracle/sap/sapdatal/system 1/system.datal
/oracle/sap/saplogl/log gl ml/logl ml.dbf
/oracle/sap/saplogl/log g2 ml/log2 ml.dbf
/oracle/sap/saplogl/log g3 _ml/log3 ml.dbf
/oracle/sap/saplogl/log g4 ml/log4 ml.dbf
/oracle/sap/dbs/cntrl1SAP.dbf

Backup Job 1

size= 36708352: file /name=/oracle/sap/sapdatal/roll_1/roll.datal
size= 10493952: file name=/oracle/sap/sapdatal/temp_1/temp.datal
size= 5251072: file name=/oracle/sap/sapdatal/ddicd_1/ddicd.datal
size= 5251072: file name=/oracle/sap/sapdatal/el30ci_1/el30ci.datal
size= 5243392: file name=/oracle/sap/saplogl/log g4 ml/log4 ml.dbf
Total=62947840
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Backup Job 2

size= 15736832: file
size= 5251072: file
size= 5251072: file
size= 5251072: file
size= 5251072: file
size= 5251072: file
size= 5251072: file
size= 5251072: file
size= 5243392: file
size= 231936: file
Total=57969664

name=/oracle/sap/sapdatal/system 1/system.datal
name=/oracle/sap/sapdata2/btabi_1/btabi.datal
name=/oracle/sap/sapdata5/ddici_1/ddici.datal
name=/oracle/sap/sapdata6/es30cd_1/es30cd.datal
name=/oracle/sap/sapdata2/poold_1/poold.datal
name=/oracle/sap/sapdata3/stabd _1/stabd.datal
name=/oracle/sap/sapdatal/pooli_1/pooli.datal
name=/oracle/sap/sapdata2/userli_1/userli.datal
name=/oracle/sap/saplogl/log gl ml/logl ml.dbf
name=/oracle/sap/dbs/cntrlSAP.dbf

Backup Job 3

size= 11812864: file
size= 5251072: file
size= 5251072: file
size= 5251072: file
size= 5251072: file
size= 5251072: file
size= 5251072: file
size= 5251072: file
size= 5243392: file
size= 5243392: file
Total=59057152

name=/dev/rdsk/c0t4d0s6
name=/oracle/sap/sapdata2/clud_1/clud.data
name=/oracle/sap/sapdata4/el30cd_1/EL30cd.datal
name=/oracle/sap/sapdata4/protd_1/protd.datal
name=/oracle/sap/sapdata2/sourced_1/sourced.datal
name=/oracle/sap/sapdata2/stabi_2/stabi.data2
name=/oracle/sap/sapdata4/userld 1/userld.datal
name=/oracle/sap/sapdatal/btabd_1/btabd.datal
name=/oracle/sap/saplogl/log g2 ml/log2_ml.dbf
name=/oracle/sap/saplogl/log g3 ml/log3 ml.dbf

Note The number of drives specified does not have to equal the number of physical tape
drives. The number of drives correlates to the number of simultaneous bpbackup
jobs run by the NetBackup for SAP on UNIX backint interface. For example, if
you had 10 SAP files and three tape drives, you can specify 10 drives in the par_file
(initSID.utl). This would cause 10 bpbackup jobs with one file for each
bpbackup job. bpsched will handle all of the job scheduling. Initially, three
bpbackup jobs would be active and the other seven jobs would be queued. You can
increase the number of active jobs and data throughput, by increasing the multiplex
value for the policy.

custom

This is a parameter value for sort_backup_type parameter. If custom is specified, the
custom_sort_file parameter needs to be set to a valid file path. An SAP Tools end-user

must create the custom_sort_file file (see “custom_sort_file” on page 112).
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type

device

This is a parameter value for sort_backup_type parameter. This parameter value will
create bpbackup jobs based on a file’s device id. The number of tape drives specified in
the intSID.ut1l file will not be used. For example, if there are 12 files requested for
backup, and they reside on two different devices (X and Y), then two bpbackup jobs will
be forked. The first job will contain all the files associated with device X and the next job
will contain all the files on device Y. The following is an example of the sort by device
option:

Input file list from SAP (brbackup, sapdba)

/oracle/sap/sapdatal/btabd_1/btabd.datal
/oracle/sap/sapdata2/btabi_1/btabi.datal
/oracle/sap/sapdata2/clud_1/clud.datal
/oracle/sap/sapdatal/ddicd_1/ddicd.datal
/oracle/sap/sapdata5/ddici_1/ddici.datal
/oracle/sap/sapdatad/el30cd_1/EL30cd.datal
/oracle/sap/sapdatal/el30ci_1/el30ci.datal
/oracle/sap/sapdata6/es30cd_1/es30cd.datal
/oracle/sap/sapdata2/poold_1/poold.datal
/oracle/sap/sapdatal/pooli_1/pooli.datal
/oracle/sap/sapdata4/protd_1/protd.datal
/dev/rdsk/c0t4d0s6 11812864
d:/ORACLE2/sap/sapdata/btabd_5/btabd.data5

Backup Job 1 (all have the device id X)

/oracle/sap/sapdatal/btabd 1/btabd.datal
/oracle/sap/sapdata2/btabi 1/btabi.datal
/oracle/sap/sapdata2/clud 1/clud.datal
/oracle/sap/sapdatal/ddicd 1/ddicd.datal
/oracle/sap/sapdata5/ddici 1/ddici.datal
/oracle/sap/sapdata4/el30cd_1/EL30cd.datal
/oracle/sap/sapdatal/el30ci 1/el30ci.datal
/oracle/sap/sapdata6/es30cd_1/es30cd.datal
/oracle/sap/sapdata2/poold 1/poold.datal
/oracle/sap/sapdatal/pooli 1/pooli.datal
/oracle/sap/sapdata4/protd 1/protd.datal

Backup Job 2 (all have the same device id Y)

/dev/rdsk/c0t4d0s6 11812864
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Note The implementation is based on the st_dev value from stat () function. This
identifies a file partition.

drive

This is a parameter value for the sort_backup_type parameter. It will create
bpbackup/bprestore jobs based off of the number of simultaneous backup jobs
specified by the drives parameter in the par_file (initSID.utl) file.

For example, if there are three tape drives and 10 SAP files, the following distribution will
occur:

Input file list from SAP

/oracle/sap/sapdatal/roll 1/roll.datal
/oracle/sap/sapdata2/sourced_1/sourced.datal
/oracle/sap/sapdata3/stabd 1/stabd.datal
/oracle/sap/sapdata2/stabi 2/stabi.data2
/oracle/sap/sapdatal/temp 1/temp.datal
/oracle/sap/sapdata4/userld 1/userld.datal
/oracle/sap/sapdata2/userli 1/userli.datal
/oracle/sap/sapdatal/system 1/system.datal
/oracle/sap/saplogl/log gl ml/logl ml.dbf

Backup/Restore Job 1

/oracle/sap/sapdatal/roll 1/roll.datal
/oracle/sap/sapdata2/stabi 2/stabi.data2
/oracle/sap/sapdata2/userli 1/userli.datal

Backup/Restore Job 2

/oracle/sap/sapdata2/sourced_1/sourced.datal
/oracle/sap/sapdatal/temp 1/temp.datal
/oracle/sap/sapdatal/system 1/system.datal

Backup/Restore Job 3

/oracle/sap/sapdata3/stabd 1/stabd.datal
/oracle/sap/sapdata4/userld_1/userld.datal
/oracle/sap/saplogl/log gl ml/logl ml.dbf
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sort_restore_type

This is an optional parameter, used to specify one of three different restore sort options
[custom | drive | image ]. If sort_restore_type is not specified it will default to the image
option.

The following is detailed information on each parameter value.

custom

If custom is specified then the custom_sort_file parameter needs to have a valid
parameter value specified. A valid custom_sort_file must be created (see page 112).

drive

This is an option for sort_restore_type parameter. It will create bpbackup/bprestore
jobs based off of the number of tape drives specified by the drives variable in the par_file
(initSID.utl)file.

For example, if there are three tape drives and 10 SAP files, the following distribution will
occur:

Input file list from SAP

/oracle/sap/sapdatal/roll 1/roll.datal
/oracle/sap/sapdata2/sourced 1/sourced.datal
/oracle/sap/sapdata3/stabd_1/stabd.datal
/oracle/sap/sapdata2/stabi_ 2/stabi.data2
/oracle/sap/sapdatal/temp 1/temp.datal
/oracle/sap/sapdata4/userld 1/userld.datal
/oracle/sap/sapdata2/userli 1/userli.datal
/oracle/sap/sapdatal/system 1/system.datal
/oracle/sap/saplogl/log gl ml/logl ml.dbf

Backup/Restore Job 1

/oracle/sap/sapdatal/roll 1/roll.datal
/oracle/sap/sapdata2/stabi 2/stabi.data2
/oracle/sap/sapdata2/userli 1/userli.datal
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Backup/Restore Job 2

/oracle/sap/sapdata2/sourced 1/sourced.datal
/oracle/sap/sapdatal/temp 1/temp.datal
/oracle/sap/sapdatal/system 1/system.datal

Backup/Restore Job 3

/oracle/sap/sapdata3/stabd 1/stabd.datal
/oracle/sap/sapdata4/userld_1/userld.datal
/oracle/sap/saplogl/log gl ml/logl ml.dbf

image

This parameter value is only for restores and is the default option if sort_restore_type is
not set in the par_file (int SID.ut1) file. To set this option, specify image (lower case)
after the sort_restore_type variable. Sort by image will group files based on their backup
image numbers and fork a bprestore for each group. For example, if nine files were
backed up by two bpbackup jobs, each file would be associated with one of two backup
image ids. If all nine files were restored, then there would be two bprestore jobs forked
by the NetBackup for SAP on UNIX backint interface. One job for each image. The files
will be grouped the way they were backed up. The following is an example of a restore.

Input file list from SAP (brrestore, sapdba):

image 1

/oracle/sap/sapdatal/roll 1/roll.datal
/oracle/sap/sapdata2/sourced 1/sourced.datal
/oracle/sap/sapdata3/stabd_1/stabd.datal
/oracle/sap/sapdata2/stabi_2/stabi.data2
/oracle/sap/sapdatal/temp 1/temp.datal

image 2

/oracle/sap/sapdata4/userld_1l/userld.datal
/oracle/sap/sapdata2/userli 1/userli.datal
/oracle/sap/sapdatal/system 1/system.datal
/oracle/sap/saplogl/log gl ml/logl ml.dbf
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Restore Job 1

/oracle/sap/sapdatal/roll 1/roll.datal
/oracle/sap/sapdata2/sourced 1/sourced.datal
/oracle/sap/sapdata3/stabd 1/stabd.datal
/oracle/sap/sapdata2/stabi 2/stabi.data2
/oracle/sap/sapdatal/temp 1/temp.datal

Restore Job 2

/oracle/sap/sapdata4/userld_1/userld.datal
/oracle/sap/sapdata2/userli 1/userli.datal
/oracle/sap/sapdatal/system 1/system.datal
/oracle/sap/saplogl/log gl ml/logl ml.dbf

Note Restore will fork another job for raw partition files if they are grouped with regular
files.

custom_sort_file

This is optional parameter, used only when the custom option is specified on either the
sort_backup_type parameter or the sort_restore_type parameter. When custom is
specified, the custom_sort_file parameter must be set to a valid file. The value must
be a full path name to a custom sort file and must have public permissions. The following
is an example of an entry:

install path/dbext/ext/db ext/sap/scripts/sap custom sort file

The custom_sort file mustinclude two fields. The first field groups a set of files to a
particular bpbackup job. Use the second field, file path name, to map the SAP backup file
list to a group ID.

Note Restore will fork another job for raw partition files, if they are grouped with regular
files.

Note If customsort is not being used then the custom_sort file parameter does not
have to be specified in the par_file initSID.ut1 file (or it does not have to equal a
valid file path).

Example of a Custom Sort File

1 /oracle/sap/sapdatal/btabd 1/btabd.datal
1 /oracle/sap/sapdata2/btabi 1/btabi.datal
1 /oracle/sap/sapdata2/clud_1/clud.datal
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/oracle/sap/sapdatal/ddicd_1/ddicd.datal
/oracle/sap/sapdata5/ddici_1/ddici.datal
/oracle/sap/sapdata4/el30cd 1/EL30cd.datal
/oracle/sap/sapdatal/el30ci 1/el30ci.datal
/oracle/sap/sapdata6/es30cd_1/es30cd.datal
/oracle/sap/sapdata2/poold 1/poold.datal
/oracle/sap/sapdatal/pooli 1/pooli.datal
/oracle/sap/sapdata4/protd 1/protd.datal
/dev/rdsk/c0t4d0s6
/oracle/sap/sapdatal/roll 1/roll.datal
/oracle/sap/sapdata2/sourced 1/sourced.datal
/oracle/sap/sapdata3/stabd 1/stabd.datal
/oracle/sap/sapdata2/stabi 2/stabi.data2
/oracle/sap/sapdatal/temp 1/temp.datal
/oracle/sap/sapdata4/userld 1/userld.datal
/oracle/sap/sapdata2/userli 1/userli.datal
/oracle/sap/sapdatal/system 1/system.datal
/oracle/sap/saplogl/log gl ml/logl ml.dbf
/oracle/sap/saplogl/log g2 ml/log2 ml.dbf
/oracle/sap/saplogl/log g3 ml/log3 ml.dbf
/oracle/sap/saplogl/log g4 ml/log4 ml.dbf
/oracle/sap/dbs/cntrlSAP.dbf

NDNMNDNMDNMDMNMNDMDNMNMMNMMNMMNMMNMMNMNRPRPRPRPRPRPRRPRRRRPR

Based on the above custom sort file, if SAP submits the entire file list to be backed up,
there would be two bpbackup jobs running at the same time. One job would have all the
files that have a 1 in the first field. The second job would have all of the files that have a 2

in the first field. The following is a list of jobs and associated files:

Backup/Restore Job 1

/oracle/sap/sapdatal/btabd_1/btabd.datal
/oracle/sap/sapdata2/btabi_1/btabi.datal
/oracle/sap/sapdata2/clud 1/clud.datal
/oracle/sap/sapdatal/ddicd_1/ddicd.datal
/oracle/sap/sapdata5/ddici 1/ddici.datal
/oracle/sap/sapdata4/el30cd_1/EL30cd.datal
/oracle/sap/sapdatal/el30ci_1/el30ci.datal
/oracle/sap/sapdata6/es30cd_1/es30cd.datal
/oracle/sap/sapdata2/poold 1/poold.datal
/oracle/sap/sapdatal/pooli 1/pooli.datal
/oracle/sap/sapdata4/protd 1/protd.datal
/dev/rdsk/c0t4d0s6
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Backup/Restore Job 2

/oracle/sap/sapdatal/roll 1/roll.datal
/oracle/sap/sapdata2/sourced 1/sourced.datal
/oracle/sap/sapdata3/stabd 1/stabd.datal
/oracle/sap/sapdata2/stabi 2/stabi.data2
/oracle/sap/sapdatal/temp 1/temp.datal
/oracle/sap/sapdata4/userld 1l/userld.datal
/oracle/sap/sapdata2/userli 1/userli.datal
/oracle/sap/sapdatal/system 1/system.datal
/oracle/sap/saplogl/log gl ml/logl ml.dbf
/oracle/sap/saplogl/log g2 ml/log2 ml.dbf
/oracle/sap/saplogl/log g3 ml/log3 ml.dbf
/oracle/sap/saplogl/log g4 ml/log4 ml.dbf
/oracle/sap/dbs/cntrl1SAP.dbf

master_time_offset

This is optional parameter, used to restore old backups if there was a time difference
between the master and client machines. This option should only be used:

¢ for restoring files backed up with NetBackup release 3.0 or older software
¢ when the date/times are out of sync between the server and client machines

The parameter value, specified in minutes, will be subtracted from the start time and
added to the end time for a restore or inquire. The following is an example of an entry:

master time offset 3

policy _log

policy log isoptional and is the name of a policy to be used for backing up a second
copy of an archive log. If this option is specified then two backups will be performed on
the same archive log. The first backup will go to the policy name option and the second
backup will go to the policy log name option.

policy log sap archive logs

sched_log

sched log is optional and is the name of a schedule to create a second backing up of an
archive log. If this option is specified, then two backups will be performed on the same
archive log. The first backup will go to the schedule option and the second backup will
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be go to the sched_1log and option. The sched log name must be a valid schedule
name under the policy log name option, otherwise it must be a valid schedule name
under the policy name option.

sched log Default-Policy

second_secondary_archive

second_secondary_archive is an optional parameter that can have a value of 0 or 1.
If value is one (1), then 2 copies of secondary backup will be made. This parameter will
have an effect only if policy logand/or sched log are specified. The first backup
will go to the policy name option and the second backup will go to the policy log
name option. Furthermore, it will support brarchive but it will have no effect on
brbackup.

retry backup

retry backup is an optional parameter and should be set to the number of retries for a
failed backup. If this option is specified BACKINT will retry a failed bpbackup job. The
number of retries is determine by the value on the retry backup parameter.

retry backup 2

fail_backup

fail backup is optional and is used to stop the backup process immediately when an
error occurs. The standard behavior of BACKINT is to continue processing even in the
event of an error and then report what files failed and what files were successful. If this
parameter is specified, then BACKINT will stop process on the first error and report
failures for all the files that were not backed up.

fail backup

Note fail backup only pertains to a specific kind of online backup. It is effective only
when tablespace is set to #BEGIN/#END backup mode and when a related file
backup takes place. This means that BACKINT has to be called with "-t file_online"
parameter.

Appendix F, backint -p par_file or initSID.utl 15 ¥



fail_backup

- 116 NetBackup for SAP System Administrator’s Guide for UNIX



Using NetBackup for SAP to Back Up
SAPDB G

NetBackup for SAP (backint for Oracle) can be used to back up SAPDB RDBMS. SAP
requires that backup applications must be able to back up any files in the file system,
regardless of the existence of Oracle on that file system. External backup tools that fulfill
this condition can be used to backup and restore SAPDB, and VERITAS NetBackup For
SAP fulfills this condition.

SAPDB relies on an additional adapter program to communicate with NetBackup for SAP.
The adapter program is part of the SAPDB distribution. This program necessitates some
additional configuration for SAPDB backups.

Follow the regular NetBackup for SAP directions in the Configuration chapter to create a
policy for SAPDB backups. This section provides the configuration that is additional to
the configuration for a regular NetBackup for SAP backup. To use NetBackup for SAP to
back up SAPDB, you must perform the following extra configuration steps:

¢ creating three configuration files on the SAPDB client

¢ defining a backup medium in SAPDB

Creating Backup Environment Configuration Files

In order to configure the backup environment to use NetBackup for SAP (backint for
Oracle) to back up SAPDB, you must create three files on the NetBackup for SAP (SAPDB)
client:

¢ backint for SAPDB configuration file
& adapter program configuration file

¢ NetBackup for SAP configuration file
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backint for SAPDB Configuration File

The backint for SAPDB configuration file provides information about the adapter
program to SAPDB. Set the environmental variable BSI_ENV to point to the name and
location of this file. The configuration file can contain the following parameters:

Parameter Description

BACKINT <absolute_path>/<file_name> Absolute path and name of the
backint program

INPUT <absolute_path>/<file_name> Absolute path and name of the
standard input file

OUTPUT <absolute_path>/<file_name> Absolute path and name of the
standard output file

ERROROUTPUT <absolute_path>/<file_name> Absolute path and name of the
standard error output file

PARAMETERFILE <absolute_path>/<file_name> | Absolute path and name of the
configuration file of the backint for
SAPDB program

TIMEOUT_SUCCESS <number> Time in seconds that the Database
Manager waits for the end of the
started Backint for SAPDB if action is
successful

TIMEOUT_FAILURE <number> Time in seconds that the Database
Manager waits for the end of the
started backint for SAPDB if errors
occur

ORIGINAL_RUNDIRECTORY <absolute_path> Absolute path of the run directory of
the source database

For a detailed description of these parameters, see the SAPDB documentation, available
on www.sapdb.org.

The following is an example of a file with the minimum configuration specified:

BACKINT /export/home/sapdb/depend/bin/backint

INPUT /export/home/sapdb/logs/backint.in

OUTPUT /export/home/sapdb/logs/backint.out

ERROROUTPUT /export/home/sapdb/logs/backint.err

PARAMETERFILE /export/home/sapdb/indep data/wrk/adapter.config

- 118

NetBackup for SAP System Administrator’s Guide for UNIX



Creating Backup Environment Configuration Files

PARAMETERFILE specifies the name and location of the adapter program configuration
file described in the following section.

Adapter Program Configuration File

The configuration file for the adapter program tells the adapter program where
NetBackup for SAP (backint for Oracle) is and provides parameters to use in
communication with NetBackup for SAP. Set the name and location of this file as the value
for PARAMETERFILE in the backint for SAPDB configuration file. The adapter
program file can contain the following parameters:

Parameter Description

STAGING AREA: <absolute_path>/<file_name> <size> Absolute path and size of a
[KB]MB|GB] temporary file

FILES PER BACKINT CALL: <number> Maximum number of temporary

files that are to be processed by
backint for Oracle concurrently.

BACKINT: <absolute_path>/<file_name> Absolute path and name of the
backint for Oracle program

PARAMETERFILE OF BACKINT: Absolute path and name of the
<absolute_path>/<file_name>h> configuration file for the backint
for Oracle program

HISTORY FILE: <absolute_path>/<file_name> Absolute path and name of the
backup history

INPUTFILE FOR BACKINT: <absolute_path>/<file_name> | Absolute path and name of the
standard input file

OUTPUT FILE FOR BACKINT: Absolute path and name of the
<absolute_path>/<file_name> standard output file

ERRORFILE FOR BACKINT: <absolute_path>/<file_name> | Absolute path and name of the
standard error output file

MAXIMAL DELAY OF BACKINT CALL: <number> Maximum waiting time in seconds
between creating a temporary file
and starting to save it by using
backint for Oracle
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Parameter Description

OMIT LAST DIRECTORY DELIMITER ON RESTORE:<YES | Specifies whether the SAPDB

| NO> adapter program ignores the
closing slash (/) of an absolute
directory name for backint for
Oracle.

Bl_CALLER_VALUE: <value> Value of the environment variable
Bl_CALLER

For a detailed description of these parameters, see the SAPDB documentation, available at
www.sapdb.org.

The following is an example of a file with the minimum configuration specified:

BACKINT: /usr/openv/netbackup/bin/backint

PARAMETERFILE OF BACKINT:

/export/home/sapdb/indep data/wrk/initSID.utl

HISTORY FILE: /export/home/sapdb/logs/BackintHistory

INPUTFILE FOR BACKINT: /export/home/sapdb/logs/backintOracle.in
OUTPUTFILE FOR BACKINT: /export/home/sapdb/logs/backintOracle.out
ERRORFILE FOR BACKINT: /export/home/sapdb/logs/backintOracle.err

NetBackup for SAP Configuration File

The last file is the NetBackup For SAP configuration file, initSID.utl. Thisfileis
specified by PARAMETERFILE OF BACKINT in the adapter program configuration file.
Use this file to set NetBackup For SAP parameters. For details, see “Configuring the
initSID.utl File” on page 55.

Defining a Backup Medium in SAPDB

Prior to running a backup, create at least one backup medium per backup type (complete,
incremental) in SAPDB. When using Backint for Oracle, the name of backup medium
created must begin with BACK. The type of backup medium must be PIPE.

The following procedure demonstrates connecting to domc11i, and then creating a backup
medium (in this case, a sample medium called BACKORA).
% To create a backup medium, run:

dbmcli -d MYSAP -u dbm,dbm
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dbmcli on MYSAP>medium put BACKORA
/export/home/sapdb/backup medium PIPE DATA 0 8

Performing a Backup

When running a backup of SAPDB, you must include the backup medium you created. In
the previous section, “Defining a Backup Medium in SAPDB” on page 120, the example
creates a backup medium called BACKORA. The following backup example uses that
sample backup medium.

The first step of the following procedure starts the utility session. You must start the utility
session before running a backup.
V¥ To run a backup:

dbmcli on MYSAP>util connect
dbmcli on MYSAP>backup start BACKORA DATA (start backup)

You can also start the backup using the DBM GUI. For more information about the DBM
GUI and configuring external backup tools, refer to the SAPDB documentation at
www.sapdb.org.
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